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Harga Rp. 4.800,- (Pulau Jawa), Rp. 5.300,- (Luar Jawa)
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PCplus
TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Teknologi Menjadi Matang oleh Waktu

Kadang kala juga oleh hukum ekonomi. Trend tentang dual channel
memory pada PC desktop ini contohnya. Ketika pertama kali dilontarkan
oleh Intel, dual channel memory memang terlihat perkasa secara teknis
dibanding pendahulunya. Pilihan Intel untuk menggunakan sistem
memori Rambus dalam platform prosesor pada waktu itu lebih didorong
oleh tuntutan teknologi dan bukan oleh hukum ekonomi pasar.

Toh, akhirnya hukum ekonomi itu menjerat jua. Seiring dengan
berjalannya waktu, Rambus tenggelam oleh teknologi memori DDR yang
memang dari segi harga jauh lebih murah. Akibatnya, di pasaran pun
praktis memori Rambus mentok dan buntu dari sisi penjualan. Dan
setelah beberapa tahun, Intel akhirnya menyerah bersikukuh dengan
Rambus dan bergeser untuk mendukung penggunaan dual channel
memory berbasis DDR.

Nah, PCplus berkesempatan untuk membandingkan dan menguji
kinerja dari sebuah sistem PC yang berbasis dual channel memory
tersebut. Apa saja dan bagaimana ulasannya bisa Anda simak di
plusFokus edisi ini. Tentu saja lengkap dengan grafik yang lengkap
sekali.

Teknologi kadang-kadang memang berwatak kaku, rigid. Pada
dirinya, sesungguhnya tak ada kepentingan. Namun ketika ada muatan
atau kepentingan ekonomi, segalanya menjadi lain. Hukum besi ekonomi
tentang permintaan dan penawaran (supply and demand) akan
senantiasa menghajar siapapun pelaku ekonomi yang menentang hukum
besi tersebut. Dan itulah yang terjadi dengan teknologi yang kami ulas di
sajian utama PCplus edisi ini.

Sajian kami yang lain tak kalah menariknya. Ulasan tentang
Microsoft Office 2003 Beta2 kami suguhkan di plusUpgrade edisi ini.
Versi Beta2 dari Microsoft Office ini boleh jadi merupakan versi Beta
terakhir sebelum raksasa software asal Redmond, Washington, tersebut
merilis versi yang siap dijual di pasar. Kami mengeruk dan mengulik
sebagian besar fitur baru selama kurang lebih satu bulan terakhir ini. Dan
hasilnya, ada banyak fitur baru yang ditawarkan oleh Office 2003 ini.
Mudah-mudahan, versi RTM (release to market) alias versi yang siap dijual
di pasar tidak terlampau drastis berubahnya dengan versi Beta 2-nya.

Sekali lagi, Office 2003 ini menunjukkan bagaimana teknologi bisa
menjadi matang oleh berjalannya waktu. Dan dari sini, kadang-kadang
kita dikendalikan oleh sebuah kekuasaan baru yang bersembunyi di balik
nalar budi kita, yakni kekuasaan yang membuat kita selalu berhasrat
untuk memiliki semua yang lebih baru, yang paling anyar.

Selamat menikmati sajian teranyar kami. Tentu saja lewat rubrik-
rubrik lain yang tak kalah gresnya.

Salam hangat dari Palmerah
Redaksi

SARAN KONTEN PCPLUS
Dear PCplus yang makin plus

aja. Saya sudah berlangganan
PCplus sejak tahun 2001. Saya ada
sedikit saran dan kritikan buat
PCplus.
1. PCplus memang "Plus" tapi

sayang plusnya malah
"plusPonsel" yang sebenarnya
tidak terlalu berhubungan
langsung dengan komputer.
Padahal pada beberapa edisi
lalu sudah ada pembaca yang
mengkritik masalah ini.
Mengenai ponsel kan sudah
ada majalahnya sendiri?
Mendingan halaman tersebut
diisi dengan plusDownload
atau plusTrik.

2. Saran buat halaman
plusDownload dan plusTrik,
alangkah baiknya bila ditaruh
pada nomor halaman misalnya
11 dan 12, tidak seperti
halaman 10 dan 11 sehingga
tidak terpisah dan gampang
mengumpulkannya. Saya
selalu menggunting halaman
tersebut bila membeli PCplus
untuk dikumpulkan. Tapi

sayang agak mengganggu
karena ada halaman 9 dan 13
yang tidak saya butuhkan. Saya
kira Redaksi tahu maksud saya.

3. Pada halaman plusMail
alangkah baiknya hanya berisi
tentang sumbang saran dan
kritikan pembaca. Karena
terkadang ada juga di luar dari
hal tersebut, misalnya ada
pertanyaan pembaca mengenai
komputer dan spesifikasinya.
Kenapa tidak ditaruh di
halaman plusInteraksi atau
halaman tambahan misalnya
plusAnda Bertanya Kami
Menjawab.

Itu aja dulu kritik dan saran
saya. Sebagai pandangan, PCplus
jangan hanya menganggap
bahwa kami membeli PCplus
hanya dibaca selama satu minggu
trus disimpan. Tapi PCplus juga
harus bisa memberi kemudahan
bagi kami untuk menyimpan atau
mengkliping halaman tersebut
sehingga apabila kami
membutuhkan sesuatu yang telah
dibahas pada edisi terdahulu jadi

gampang mencarinya, sehingga
tidak harus membolak-balik
sekian puluh edisi. Karena banyak
pembaca yang bertanya selalu
PCplus jawab buka edisi sekian
halaman sekian. Terima kasih.

Eris Suhenda
vistindo@yahoo.com

Red: Terima kasih sarannya Bung Eris.
Juga kepercayaannya memilih PCplus
sebagai bacaan wajib. Sering kali,
penataan rubrik berubah pada saat-
saat akhir deadline akibat perubahan
iklan. Tetapi kami akan
mengupayakan kenyamanan seperti
yang Anda minta.

USUL DAN MINTA TOLONG
Salam hangat untuk crew

Redaksi PCplus. Saya pelanggan
setia tabloid Anda di kota Solo.
Sebagai pelaku&penggemar dunia
komputer, saya berprofesi di bidang
designer web/animasi/video efek
dan lain-lain. Saya mo minta
bantuan pada PCplus, langsung aja
ya.
1. Mohon agar PCplus

mengangkat informasi/tips
mengenai langkah atau cara
untuk mendaftarkan hasil dari
Web yang kita design, dari cara/
langkah awal mendaftar pada
site gratisan sampai Web bayar
(hosting+domain), berikut cara/
langkah untuk upload (transfer
data) secara lengkap & benar,
mohon sertakan contoh site
gratisan seperti Yahoo, Google
dan lain-lain, berikut contoh
penyedia layanan Web/hosting
gratis+bayar baik dalam negeri
maupun luar negeri.

2. Saya minta informasi spesifikasi
lengkap dari handphone Nokia
N9210 & 9210i, tolong redaksi
sertakan gambar (ukuran 500
atau 600) + fungsi tombol,
kelebihan, cara pakai, dan lain-
lain.

3. Apakah kedua handphone
tersebut bisa  untuk surfing
Internet, chatting, camera web
gambar video, dan lain-lain?

4. Mohon redaksi mengupas
tuntas langkah menggunakan
Adobe Photoshop secara garis
besarnya dengan
lengkap&mudah. Mohon PCplus
mengabulkannya, saya tunggu
balasan&terbitannya di kota
Solo, semoga sehat&sukses
selalu untuk crew PCplus semua,
saya tunggu ulasannya. Thanks.

Hendry AS
gorguth@bolehmail.com

gorguth@plasa.com
Jl Lomban-Tobing No:31 Surakarta

57133

Red: Sebenarnya, permintaan ulasan
dari Anda sudah pernah kami bahas
semuanya. Ulasan tentang Nokia 9210
bahkan sudah kami bahas tahun lalu.
Yang jelas, handphone tersebut bisa
untuk surfing Internet tetapi belum
memiliki fasilitas sebagai webcam.

ULAS LINUX
Halo PC+. Bagaimana kalau

PC+ banyak mengulas tentang
dunia OS Linux dari pengenalan
jenis-jenis distronya,
penginstalannya, sampai tips/trik
dan troubleshoting-nya, dan lain-
lain. Pokoknya serba Linux deh!
OK.Terima kasih.

Maruli D.P
morsoft@plasa.com

Red: Sudah kami penuhi permintaan
Anda, Bang!

PENAWARAN WORKSHOP
KALIMANTAN

Salam hormat to redaksi PC+
yang makin OKE.....Saya adalah
salah satu pembaca setiamu. Begini,
beberapa waktu yang lalu saya
kirim e-mail ke Redaksi PC+ tentang
permohonan kerja sama
menyelenggarakan workshop-
workshop yang akhir-akhir ini
frekuensinya semakin sering di
daerah-daerah. Acung dua jempol
deh buat PC+ buat atensinya ke
daerah-daerah.

Kemudian saya dapat
balasan dan diminta melampirkan
profil lembaga pendidikan saya
agar menjadi pertimbangan.
Namun mohon maaf sekiranya
format profilnya kurang cocok dan
hingga kini tak ada respon kembali.
Untuk itu kali saya coba kembali
kirim profil lembaga saya, dan
kiranya mendapat respon serta
penjelasan yang memuaskan saya
jika lembaga saya masih kurang
layak untuk bekerja sama dengan
PC+, mohon selengkap-lengkapnya
ya supaya saya tidak kecewa dan
mendapat kepastian tentunya.
Mohon maaf jika formatnya masih
kurang bagus juga, maklum orang
daerah pelosok. Wassallam.

Puguh Sartono
rangga_xp@yahoo.com

Kalimantan

Red: Kami bukannya mengabaikan
usulan tersebut Bung Puguh. Sejauh ini,
tim promosi PC+ selalu mem-follow-up
permintaan workshop di daerah-
daerah. Tentang bisa tidaknya, biasanya
kami menyesuaikan dan melakukan
koordinasi dengan para sponsor kami
mengenai dukungan mereka untuk
menyelenggarakan workshop di daerah
dimaksud. Apabila semuanya beres,
PCplus pasti akan mengonfirmasi  bisa
tidaknya program workshop dijalankan.
Sekali lagi, terima kasih atas penawaran
kerja samanya.

ANGKET BERHADIAH SAAT
ULTAH

Saya ANDHIKA, pembaca
PCplus. Saya mau usulkan,
bagaimana kalau edisi Ulang Tahun
ke-3 nanti PCplus mengadakan
angket berhadiah buat pembaca?
Demikian usul saya. Terima kasih.

Andhika R
Ketanggungan Wirobrajan JOGJA

Red: Usulan Anda akan kami godok
di dapur Redaksi kami, Bung!

PEMROGRAMAN
INTERAKTIF

Hi .... Salam sejahtra selalu
untuk Redaksi. Saya punya usul,
bagaimana kalau PCplus juga
membikin rubrik interaktif
tentang pemprograman gitu,
semacam tanya jawab gitu.
Semoga PCplus makin jaya dan
tambah berisi lagi sesuai motto-
nya, makin plus bicara PC.

Abdul Hamid
Jl.Kartini Gg.Mawar Rt 9 No 27

Samarinda

Red: Boleh juga usulnya Bung Hamid.
Sedikit meluruskan motto kami,
“Paling Plus Bicara PC”.

HARGA SOFTWARE ORIGI-
NAL

Halo PCplus ketemu lagi. Saya
punya beberapa pertanyaan nih!
1. Kan sekarang sudah

dikeluarkan UU tentang
software bajakan. Nah yang
saya mau tanyakan di mana sih
saya bisa membeli software-
software original, soalnya saya
lihat hampir semua toko
software semuanya bajakan.
Terutama di daerah Bogor
atau Jakarta.

2. Saya mau usul, bagaimana
pada rublik plusHarga
ditambahkan harga software-
software original, seperti harga
Windows dan sebagainya.

Satri Nugraha
satri_n@telkom.net

Red: Usulannya boleh juga. Kami
akan coba masukkan, tetapi update
harganya bisa jadi tidak rutin kami
lakukan setiap minggunya, karena
harganya relatif tetap/tidak fluktuatif
sebagaimana harga komponen
hardware.

HAPUS POP-UP
Redaksi yang terhormat, saya

ingin menanyakan bagaimana
cara menghilangkan pop up? Saya
sudah mencoba memakai Trust
Killer tetapi tidak menghapus
secara keseluruhan. Setiap saat
muncul dan di-kill oleh Trust
Killer tetapi beberapa saat
kemudian muncul lagi. Saya ingin
menghapusnya secara permanen.
Terima kasih.

Ahmad Fajar
afajars@plasa.com

Red: Bung Fajar, berkali-kali rubrik
plusDownload menyajikan ulasan
tentang apa yang Anda butuhkan.
Cobalah cari arsipnya.

RALAT:
Pada plusPortal Edisi 140 ada
kesalahan penulisan alamat
situs. Di situ tertulis
bbc.football.fantasyleague.
co.uk. Seharusnya bbcfootball.
fantasyleague.co.uk
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IBM Luncurkan Program “TECHNOLOGY FOR THE
COMMUNITY”. Sebagaimana diketahui, Instruksi Presiden No. 3 Tahun 2003 telah
memberikan arah  dan  strategi bagi pengembangan e-government di Indonesia.

“Di  seluruh dunia, IBM tidak hanya sekadar menyumbangkan peranti keras dan lunak komputer
tetapi terutama mendedikasikan berbagai keahlian dan keterampilan  yang  dimilikinya  untuk
membantu masyarakat dalam menjadikan teknologi sebagai  bagian dari kegiatan mereka sehari-hari,”
kata Betti Alisjahbana, Presiden  Direktur  IBM Indonesia, dalam acara jumpa pers di Jakarta (25/8).

“Khusus di Indonesia, bersamaan dengan semakin seriusnya pemerintah
menggalakkan pengembangan e-government, kami melihat peluang yang besar
untuk memberikan kontribusi melalui pemberdayaan masyarakat—mulai  dari anak-anak  berusia pra-
sekolah hingga pelajar dan mahasiswa,”  tambah Betti.

Di seluruh dunia, selama beberapa tahun terakhir ini IBM mempunyai program yang bertemakan
“Reinventing Education” yang merupakan bagian dari kegiatan IBM  Corporate  Community Relation.
Tujuannya adalah mempersiapkan generasi muda untuk memasuki dunia yang akan sangat bergantung
pada teknologi informasi. Salah satu inisiatif IBM ini difokuskan pada upaya meningkatkan penerapan
teknologi melalui kegiatan belajar-mengajar dengan mengembangkan solusi-solusi teknologi yang
secara spesifik diarahkan untuk pemakaian di ruang kelas serta menemukan metode-metode  baru
untuk merangsang minat belajar para siswa dan meningkatkan antusiasme mereka dalam mengenal
dan menggunakan teknologi.

Kini,  program  Reinventing  Education  tersebut tumbuh menjadi sebuah
program dengan total dana  70 juta dolar AS di seluruh dunia, di samping menjadi  prakarsa reformasi
sekolah paling besar yang pernah diluncurkan oleh sebuah perusahaan global. Sampai hari ini, program
jangka panjang ini telah melibatkan sekitar 65 ribu guru dan hampir enam juta murid sekolah di
seluruh dunia. Program-program yang diluncurkan IBM itu antara lain:
1. KidSmart, program untuk pendidikan usia dini yang didukung oleh teknologi komputer dan

perangkat lunak yang menarik, interaktif, dan ditargetkan bagi anak-anak berusia 3-9 tahun.
Salah  satu  aspek  kunci  dari program ini adalah pelatihan bagi pengajar.

2. Try  Science, program yang terdiri atas pemberian sumbangan berupa  kios “Around the World”
yang memungkinkan anak-anak melakukan eksplorasi dan berkenalan dengan ilmu pengetahuan
melalui cara-cara baru yang dinamis. Konten yang disediakan berasal dari sumbangan museum-
museum IPTEK terkenal di seluruh dunia.

3. EXITE  (EXploring Interests in Technology and Engineering), suatu program yang ditujukan kepada
murid-murid wanita di sekolah menengah  (SLTP/SLTA), kesempatan  untuk mengeksplorasi
teknologi serta bekerja secara kolaboratif dalam proyek-proyek yang berkaitan dengan
matematika dan ilmu  pengetahuan.

4. APICTA (Asia Pacific ICT Awards), suatu lomba desain aplikasi tingkat  internasional.  Di tingkat
Indonesia, perlombaan ini diselenggarakan oleh ASPILUKI. (snu)

Menggertak Pesaing Melalui Investasi IT. Hotline Advertising,
sebuah perusahaan periklanan nasional secara resmi mulai 20 Agustus lalu mengimplementasikan
teknologi informasi dalam menjalankan bisnisnya. Selain untuk lebih memaksimalkan pelayanan kepada
para klien mereka, salah satu implementasi ini adalah menggertak pesaing-pesaing dari biro iklan lain
yang jumlahnya tak kurang dari 200 biro iklan.

Dalam media workshop bertajuk “Merangkul Teknologi untuk Memenangkan Persaingan di Masa
Depan”, terungkap perusahaan ini sudah mengimplementasikan IP Telephony dalam berhubungan
dengan klien-kliennya. Dengan solusi semacam ini, bisnis dengan klien bisa dilakukan dengan cara
teleconferencing. Selain itu, untuk memberikan layanan lebih cepat, mereka memberikan layanan Web
based kepada para klien. Contact report pun juga dilakukan lewat aplikasi yang sarat dengan teknologi.

“Implementasi IP telephony secara penuh merupakan langkah maju dari Hotline dalam
memanfaatkan teknologi jaringan untuk menggabungkan kebutuhan telekomunikasi dan komunikasi
data dalam satu jaringan tunggal berbasiskan IP (Internet Protocol),” ujar Irfan Setiaputra, Managing
Director Cisco Systems Indonesia.

Dalam workshop tersebut juga terungkap, untuk solusi IT yang didukung oleh perusahaan IT macam
Cisco dan Microsoft tersebut, Hotline telah mengeluarkan budget sekitar 300 ribu dolar AS. Menurut
Subiakto Priosoedarsono, CEO Hotline Advertising, kebijakan ini memang sengaja dilakukan sebagai salah
satu strategi untuk memenangkan persaingan yang semakin ketat. (sil)

Oracle Terdepan dalam Solusi Pemenuhan Pesanan.
Begitulah hasil studi Forrester Research baru-baru ini. Penilaian tersebut berdasarkan evaluasi Forrester
Research atas 13 penawaran pemenuhan pesanan (order fulfillment) dari produk terbaik dan
perusahaan aplikasi paket. Aplikasi pemenuhan pesanan membantu perusahaan mengelola dan meng-
organisir pesanan untuk barang atau layanan secara elektronik, baik internal maupun eksternal. (alx)

Virus “SoBig.F” Menghantam
Berbagai Jaringan Komputer di
Seluruh Dunia. Sebagian besar analis virus
menganggap bahwa virus ini termasuk bukan virus sembarangan
dan tidak diciptakan oleh orang yang sekadar iseng atau usil.
Diyakini, serangan dari virus ganas ini bermula dari sebuah situs
porno. Jimmy Kuo, peneliti pada perusahaan pembuat antivirus
Network Associates Inc mengatakan, “Sobig.F pertama kali di-
posting di sebuah group Usenet porno.” Usenet adalah forum
yang sangat populer di Internet di mana para pengguna komputer
dengan minat atau hobi yang sama saling berkirim dan membaca
pesan.

Sobig.F ini diprogram untuk menyerang komputer lewat e-
mail dengan mengunakan teknis social engineering untuk
memancing user masuk ke perangkatnya. Subject dan text pada
e-mail dan attachment yang dikirim beranekaragam atau berbeda-
beda. Beberapa di antaranya adalah "Thank You!," "Re: Details"
atau "Re: That Movie."

Menurut analisa Panda Software’s Virus Laboratory, Sobig.F
juga bisa men-download file dari Internet. Di samping itu, worm
tersebut memiliki fungsi pintu belakang alias back door, yang akan
mengizinkan worm ini membuka port komunikasi dan menyerang
luas ke jaringan komputer.

Sebuah jaringan komputer yang terkena virus ini dikabarkan
bisa lumpuh total dalam waktu beberapa jam. Jika user
menjalankan attachment yang memiliki worm tersebut, dengan
sendirinya worm ini akan menggunakan engine SMTP-nya dan
mengirim dirinya ke semua alamat e-mail yang terdapat pada
komputer yang terinfeksi Adapun extension yang terkirim di
antaranya adalah TXT, HTM*, WAB, DBX, dan .EML. Worm ini juga
mengopi dirinya dalam komputer yang terinfeksi di bawah nama
winppr32.exe dan menciptakan beberapa entry pada Windows
Registry untuk selalu bereaksi bila komputer yang terinfeksi itu
dijalankan. (snu)

Tim Olimpiade Komputer Indone-
sia Batal Berangkat ke AS. TOKI ini
seharusnya akan beradu cerdas dengan para pesaing dari berbagai
negara di bidang komputer dan pemrograman. Namun apa daya.
Keduataan AS di Indonesia tidak mengeluarkan visa untuk para
anggota tim, sehingga mereka gagal berangkat ke AS. Keempat
siswa Indonesia tersebut adalah Derianto Kusuma (SMP Kanisius
Jakarta), Budiarto Herman (SMU Regina Pacis Bogor), Pascal
Alfadian Nugroho (SMU Kanisius Jakarta), dan Stephanus Indra
(SMU BPK Penabur I Jakarta).

Donald T. Piele, profesor matematika di University of Wiscon-
sin  Parkside, selaku tuan rumah penyelenggara IOI XV
menyatakan tidak bisa berbuat apa pun dalam hal ini baik untuk
delegasi Indonesia maupun negara-negara lain yang mengalami
kesulitan serupa. "Very sorry to hear about the problems for you. I
wish I could have helped. Other countries are having problems too.
We will miss you," demikian pesannya. Konon, langkah ini ditem-
puh oleh AS akibat peristiwa serangan teroris 11 September 2001.

Sebelumnya tidak kurang berbagai cara telah ditempuh dalam
usaha mendapatkan visa ini. Berbagai surat rekomendasi baik dari
Departemen Pendidikan Nasional, Departemen Luar Negeri,
maupun dari Sekretariat Negara telah diberikan. Usaha
menghubungi Departemen Luar Negeri Amerika Serikat di Wash-
ington DC juga telah dilakukan, namun tetap saja hal-hal tersebut
tidak membuahkan hasil.  Tidak sedikit tentunya yang harus
dibayar dengan kejadian ini baik secara materil lebih-lebih secara
non materil. Dan kesempatan untuk meraih prestasi itupun
tertunda.

Saat ini tim akan diarahkan langsung untuk mempersiapkan
Tim Olimpiade Komputer Indonesia 2004 mengikuti IOI XVI di
Athena, Yunani bulan Agustus tahun 2004 yang akan datang.

Jangan menyerah kawan, kalian bukan teroris dan buktikan
ketangguhanmu di negeri Plato nanti! (snu)

Datascrip Lakukan Trade-In
untuk Produk Scanner. Guna mendapatkan
scanner yang sesuai dengan perkembangan teknologi digital saat
ini, Datascrip yang dikenal sebagai distributor perangkat
elektronik Canon menawarkan program untuk para pengguna
scanner, yaitu trade-in. Program ini memberikan kesempatan
pemilik scanner-scanner lawas untuk menukarkannya dengan
produk-produk scanner terbaru dari Canon. Program yang terbuka
untuk umum ini berlangsung dari tanggal 28 Agustus hingga 8
September mendatang dan bertempat di showroom Datascrip
Bandar Kemayoran, Jakarta Electronic City SCBD, dan Kelapa
gading, serta toko-toko komputer terkemuka.

“Apapun mereknya bisa ditukar dengan menambah sejumlah
dana sesuai dengan produk yang dipilih,” Ungkap Intan, Media
Relation Officer Datascrip pada PCplus ketika dihubungi PCplus
melalui telepon. Tertarik? (sil)
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Sebanyak 13 Ribu Kartu Kredit
AL AS Dibobol Maling Digital.
Maling ini berhasil masuk ke sebuah situs dan men-download
nomor kartu kredit dan catatan billing dari transaksi yang
dilakukan oleh Angkatan Laut AS. Kartu-kartu kredit ini sebelum
disalahgunakan biasanya digunakan untuk membayar berbagai
keperluan operasional kantor.

Citibank, bank yang mengeluarkan kartu kredit tersebut
tidak menemukan aktivitas yang mencurigakan maupun
penyalahgunaan atas kartu kredit yang sudah dicuri tersebut.
Pencurian diduga sudah dilakukan sejak bulan Juli lalu. Setelah
mendengar kasus ini, pihak bank telah mengganti 13 ribu kartu
yang telah dicuri tersebut, dan separuh dari kartu-kartu tersebut
telah diaktifkan kembali dan bisa digunakan sebagaimana
mestinya.

Petugas gabungan dari Angkatan Laut dan Departemen
Pertahanan tengah melakukan penyelidikan untuk mencari
gambaran bagaimana hacker tersebut melakukan eksploitasi
tersebut. Tim ini juga sekaligus mencari cara untuk
menanggulangi kejadian serupa di masa yang akan datang.

Guna mengurangi peluang terjadinya penyalahgunaan
tersebut, AL AS juga telah mulai melakukan penggantian
terhadap 9 ribu kartu kredit lain yang belum sempat dicuri
nomornya. Sebagian kartu-kartu kredit itu memiliki limit
pembelanjaan mencapai 2.500 dolar AS. (snu)

Zyrex Luncurkan Plasma TV
Monitor. Peluncuran secara resmi dilakukan pada Rabu
(20/8). Timothy Siddik, Presiden Direktur PT Zyrexindo Mandiri
Buana mengatakan, “Zyrex memilih produk Plasma TV Monitor
karena lebih melihat kepada pengguna high end, baik personal
maupun korporat.”

Zyrex juga membuat suatu program bertajuk  “Beli Zyrex,
bawa pulang dengan VIOS”. Program promo ini dimulai tanggal
1 Agustus sampai 31 Desember 2003 dan berlaku di seluruh
Indonesia untuk pembelian produk Zyrex selain monitor dan
spare part. Siapa-siapa saja yang beruntung akan diumumkan
pada tanggal 16 Januari 2004. (alx)

Motorola Luncurkan Dua Ponsel Baru.
Motorola, yang belum meluncurkan ponsel dengan kamera built-in,
walaupun merek lain sudah, meluncurkan ponsel dengan kamera yang sudah
built-in. Serinya adalah Motorola E365. Untuk mendukung kamera dan MMS,
E365 mampu menampilkan 65.000 warna dengan resolusi layar 128x160 pixel.
Untuk suara, E365 ini didukung oleh ringtone polifonik 40 suara dan
beberapa suara efek. Uniknya, lensa E365 memiliki cover yang belum pernah
disertakan oleh produsen ponsel dengan kamera built-in lainnya.

Motorola juga meluncurkan ponsel yang sporty dan compact, yaitu
Motorola C200. Ponsel kelas low-end ini bisa dikostumasi luar-dalam.
Kostumasi luar dapat dilakukan dengan mengganti cover depan dan
belakang, sedangkan kostumasi dalam dengan men-download screen saver
dan semacamnya. (alx)

SAP Tawarkan Solusi Industri Spesifik ke Usaha
Kecil dan Menengah. Solusi Industri Spesifik bagi Usaha Kecil dan Menengah (UKM)
ini berbiaya mulai dari US$ 150.000. Harga itu sudah termasuk lisensi software, hardware serta
pelatihannya.  Dalam jangka waktu 100-150 hari, solusi siap diimplementasikan. “Dengan solusi ini, kami
tidak meringkas solusi bisnis standar SAP yang biasa digunakan oleh perusahaan besar untuk diterapkan
pada perusahaan-perusahaan menengah. Mereka akan mendapatkan aplikasi SAP yang sama, namun

dengan teknologi yang berbeda,” begitu
ungkap Krish Datta, Managing Director PT
SAP Indonesia.

Untuk menyediakan Solusi Industri
Spesifik ini SAP bekerja sama dengan
beberapa mitra lokal seperti Astragraphia-IT,
IMC Consulting Alliance, Magnus, Metrodata,
Perdana Consulting, dan SDI Technologies.
SAP menanamkan investasi sebesar US$ 1 juta
selama dua tahun pertama untuk mendukung,
mengembangkan, dan memasarkan solusi ini.
Krish Datta menambahkan, “Kami bekerja
sama dengan para mitra lokal yang telah
berpengalaman guna menyediakan solusi
yang mampu memberikan hasil maksimal.”

Langkah SAP yang memberikan perhatian
pada pasar UKM ini sesuai dengan prediksi IDC yang memperkirakan pasar UKM di Asia Pasifik akan
tumbuh rata-rata 18.5% per tahunnya hingga 2004. Hal ini tentu saja akan mempengaruhi pertumbuhan
teknologi informasi di UKM. (alx)

ARE/PCplus



| 5

plusBelajar IV • 20 - 26 Agustus 2003
PCplus 140



6 |

plusPortal IV • 27 Agustus - 02 September 2003
PCplus 141

Virtual Private Network:
Aman di Tempat Rawan

Alex Pangestu
alex@e-pcplus.com

J

Keamanan selalu
menjadi isu penting di
dalam suatu jaringan,

baik itu LAN, WAN
apalagi Internet.

Lebih penting lagi jika
jaringan sudah

diaplikasikan untuk
menopang kegiatan

bisnis perusahaan
yang sebagian

informasinya tertutup,
hanya bisa dilihat oleh

pihak tertentu saja.

ika sebuah
perusahaan
yang tidak memiliki
kantor cabang, LAN

bisa digunakan sebagai jaringan.
Namun jika sebuah perusahaan
seperti bank yang memiliki
berbagai kantor cabang,
diperlukan suatu jaringan yang
jauh lebih luas agar cabang-
cabang tersebut terhubung ke
pusat. WAN dengan leased line
bisa digunakan untuk
menghubungkan mereka.

Walaupun dedicated, lebih
aman dan cepat dibanding
Internet biasa, leased line
membutuhkan biaya yang
meningkat apabila jarak antara
yang dihubungkan semakin jauh.
Bayangkan jika cabang yang
dimiliki oleh suatu perusahaan
tersebar di berbagai kota.

Untuk mengatasi masalah
harga yang meningkat seiring
dengan jarak yang semakin jauh,
banyak perusahaan yang
menggunakan intranet yang
berupa situs yang hanya dapat
diakses oleh karyawan mereka.
Belum lama ini, berkembang
teknologi lain, yaitu Virtual
Private Network (VPN), yang juga
dapat digunakan untuk
memenuhi kebutuhan
perusahaan yang memiliki
cabang-cabang yang jauh.

Sederhananya, VPN dapat
diartikan sebagai sebuah
jaringan pribadi yang
menggunakan koneksi jaringan
yang lebih luas (baca : Internet)
untuk menghubungkan dua atau
lebih jaringan. Seperti artinya,
VPN tidak menggunakan leased
line sebagai hubungan antar
jaringan, namun menggunakan
koneksi virtual melalui Internet.

TIPE-TIPE
Secara umum, VPN dibagi

menjadi dua jenis. Pembagian
tersebut berdasarkan siapa yang
dihubungkan ke jaringan milik
perusahaan.

Jenis yang pertama adalah
Remote-Access, yang sering
pula disebut sebagai Virtual
Private Dial-up Network (VPDN).

Pada VPN jenis ini, yang
terhubung ke jaringan
perusahaan adalah individual,
bukan jaringan lain. Sang indi-
vidual tersebut bisa karyawan-
karyawan yang bekerja di
lapangan namun tetap perlu
terhubung ke jaringan
perusahaan. Si karyawan men-dial
nomor khusus untuk terhubung
ke jaringan dan menggunakan
software untuk “menyelami”
jaringan. Untuk jaminan
keamanan, Remote-Access
menggunakan jaringan yang
terenkripsi. Hanya data tertentu
saja yang bisa dilewatkan di
jaringan ini.

Jenis VPN yang ke dua adalah
Site-to-Site yang
menghubungkan antara dua atau
lebih jaringan. Site-to-Site
memiliki dua tipe, yaitu Intranet-
based dan Extranet-based.
Intranet-based menghubungkan
beberapa jaringan milik satu
perusahaan, sedangkan Extranet-
based menghubungkan jaringan-
jaringan milik beberapa
perusahaan yang berbeda. Tipe
yang terakhir bisa digunakan bila
sebuah perusahaan memiliki kerja
sama dan membutuhkan jaringan.

CARA KERJA
Supaya jelas perbedaan

antara Internet, WAN dan VPN
bisa digunakan perumpamaan-
perumpamaan. Bayangkanlah
Indonesia yang memiliki beribu-
ribu pulau. Anggaplah setiap
pulau adalah sebuah LAN.

Untuk berjalan-jalan ke pulau
lain, biasanya kapal feri lah yang
digunakan. Siapa saja yang bisa
menggunakan kapal feri? Yah,
semua orang, sehingga tidak ada
lagi privasi. Antara beberapa
kapal feri pun masih bisa saling

pandang. Inilah perumpamaan
untuk Internet.

Agar lebih aman berjalan-
jalan antar pulau, bisa saja orang
yang teramat kaya membangun
jembatan ke pulau lain. Dengan
menggunakan jembatan ini, si
kaya tersebut bisa berjalan-jalan
dengan aman dan memiliki
privasi. Namun semakin jauh
pulau, semakin panjang jembatan
dan semakin mahal biaya
pembangunannya. Situasi seperti
ini cocok dengan pembangunan
leased line.

Dari pada membangun
jembatan yang mahal, si kaya
berpikir untuk membeli sebuah

kapal selam pribadi. Dengan
menggunakan kapal selam, si
kaya bisa berjalan-jalan hampir
tanpa gangguan. Kecepatan,
privasi dan keamanan terjamin.
Demikian pula halnya VPN.

KEAMANAN
Keamanan pada VPN

menjamin privasi dan tidak
bocornya data yang dialirkan di
dalamnya. Ada beberapa metode
yang umum digunakan untuk
keamanan pada VPN, yaitu
Firewall, Encryption, IPSec dan
AAAServer.

Istilah Firewall sudah umum
di bidang keamanan jaringan.
Firewall adalah tembok antara
suatu jaringan pribadi dengan
Internet. Firewall dapat diatur
agar hanya data-data tertentu
yang boleh dilewati serta
protokol-protokol mana yang
boleh masuk.

Begitu juga Encryption,
diterjemahkan menjadi enkripsi,
sering didengar untuk menjamin
keamanan data di Internet.
Enkripsi digunakan untuk
mengubah data menjadi format

tertentu sebelum dikirim agar
data tersebut tidak dapat
dimengerti apa isinya sebelum
didekrip. Sistem yang mengirim
mengenkrip data, sedangkan
sistem yang menerima mendekrip
data sehingga bisa dibaca
kembali.

Ada dua macam enkripsi yang
umumnya digunakan, yaitu
enkripsi dengan Symetric-key
dan enkripsi dengan Public-key.
Pada enkripsi dengan Symetric-
key setiap sistem memiliki sebuah
kode rahasia yang dapat
digunakan untuk mengenkrip
data sebelum data tersebut
dikirim ke sistem lain melalui

suatu jaringan. Kode rahasia yang
sama harus dimiliki oleh sistem
lain yang menerima data.

Public-key menggunakan
kombinasi Private-key dan
Public-key. Private-key hanya
diketahui oleh satu sistem,
sedangkan Public-key diberikan
oleh sistem pengirim data kepada
sistem penerima data. Untuk
mendekrip suatu data yang
terenkrip, sistem penerima data
menggunakan Public-key yang
diberikan dan Private-key
miliknya.

Metode berikutnya adalah
IPSec, kepanjangan dari Internet
Protocol Security. IPSec
merupakan protocol yang
menyediakan fitur keamanan
seperti enkripsi, namun ditambah
dengan autentikasi atau
konfirmasi. IPSec memiliki dua
model enkripsi, yaitu tunnel dan
transport. Tunnel mengenkrip
header beserta isi paket yang
dikirim, sedangkan transport
hanya mengenkrip isi paket.

AAA Server digunakan
untuk VPN jenis Remote-Access
agar lebih aman. AAA adalah

kepanjangan dari Authentica-
tion, Authorization dan
Accounting. Dengan demikian
seorang karyawan yang
mengakses VPN akan diperiksa
siapa dia, apa yang berhak dia
lakukan serta apa yang sedang
dilakukannya.

KEBUTUHAN
Apa yang dibutuhkan untuk

membangun VPN tergantung dari
tipe VPN yang digunakan (Re-
mote-Access atau Site-to-Site).
Secara umum elemen-elemen yang
digunakan untuk membangun
VPN adalah software untuk
masing-masing client, hardware
seperti VPN concentrator atau PIX
firewall, VPN server, Network
Access Server (NAS) untuk VPN tipe
Remote-Access serta pusat policy-
management.

Software yang diberikan ke
klien merupakan suatu tool agar
seseorang dapat login ke dalam
VPN. Misalnya seorang karyawan
yang ingin masuk ke VPN
perusahaannya, ia butuh software
ini untuk dapat menyelami
jaringan milik perusahaan.

Berbagai hardware seperti
VPN concentrator, PIX firewall atau
VPN optimizer router digunakan
untuk menjamin kemanan VPN.
Hardware seperti itu memiliki
kemampuan untuk mengenkrip
serta meningkatkan performa VPN.

TUNELLING
Tunelling merupakan hal

yang penting pada VPN karena
menjamin privasi data. Tunneling
adalah proses penempatan data ke
dalam paket lain yang terenkrip
dan mengirimnya melalui suatu
jaringan (Internet). Protokol yang
digunakan paket dapat dimengerti
oleh sistem pengirim, jaringan
(Internet) dan sistem penerima.

Tunelling membutuhkan tiga
buah protokol, yaitu Carrier
Protocol (protokol yang
membawa data di Internet),
Encapsulating Protocol
(protokol yang membungkus
data), dan Passenger Protocol
(data yang dibawa).

Untuk mudahnya, Tunelling
dapat diumpamakan seperti
mengirim ponsel dengan TIKI.
Passanger Protokol adalah
ponsel. Bungkus dari ponsel dan
bungkus dari TIKI adalah Encapsu-
lating Protocol, yang hanya
boleh dibuka oleh penerima.
Carrier Protocol-nya adalah
kendaraan yang digunakan oleh
TIKI untuk mengirimkan ponsel ke
tujuan.

Dengan adanya jalur khusus,
walaupun tetap menggunakan
jaringan Internet yang ada, serta
keamanan yang terjamin,
memungkinkan sebuah
perusahaan dengan karyawan
yang tersebar di mana-mana tetap
terhubung. PC+
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Babylon:
Salah Satu Tools Komputer

yang Paling Berguna

Y.J. Thurana
thurana@e-pcplus.com

D

Pernah menonton Mc
Gyver? Salah satu
pahlawan favorit

saya. Bukan karena ia
berkekuatan super,

bisa merayap di
dinding, terbang

secepat pesawat jet
ataupun memiliki

kuku yang bisa
menyayat logam

seperti pisau
membelah tahu,

melainkan karena ia
manusia biasa.

ua hal yang paling
saya sukai dari dia;
keengganannya
menggunakan senjata,

dan kemampuannya untuk
memanfaatkan segala macam
benda yang bisa ia temukan di
sekelilingnya untuk mengeluarkan
dirinya dari kesulitan. Masih jelas
di ingatan ketika ia membuat
peledak mini dari kombinasi
bahan-bahan untuk mencuci, atau
ketika ia menyumbat bocoran
radio aktif dengan permen coklat
batangan!

Ada lagi ciri khas darinya,
selalu membawa pisau lipat
serbaguna buatan Swiss di
kantongnya. Baik untuk
memotong, membuka tutup
botol, mengencangkan sekrup,
menggunting, bahkan mencungkil
gigi. Betul-betul serba guna.

Nah, jika mau mengibaratkan
diri Anda sebagai Mc Gyver di
depan komputer, maka pisau lipat
serbaguna itu mungkin adalah
perangkat lunak yang bernama
Babylon.

POWERFUL
Berlawanan dengan

kebiasaan saya yang selalu
berusaha membahas program
yang gratis dan berukuran kecil,
kali ini tidak ada kemewahan
seperti itu. Bukan karena berusaha
untuk menyulitkan hidup Anda,
tetapi sederhananya karena
fungsionalitas program ini. Jika
ada program yang layak untuk
dibayar sesuai dengan
kemampuannya, ini adalah salah
satunya.

Berawal dari sebuah program
kecil penerjemah bahasa, Babylon
berkembang menjadi program
yang serba bisa. Mungkin setara
dengan pusat informasi pribadi.
Dari menterjemahkan multibahasa
(termasuk bahasa Indonesia!),
menyediakan informasi mengenai
topik tertentu, mengonversi mata
uang, suhu, cuaca, waktu, satuan,
kalkulasi, menyimpan hasil penca-
rian, sampai membuat sendiri
kamus pribadi dan mempublika-
sikannya ke seluruh dunia.

Mungkin fasilitas terakhir
itulah yang membuat Babylon
berkembang dengan sangat pesat.
Selain banyak bermunculannya
kamus-kamus bahasa --termasuk
bahasa yang bukan merupakan
bahasa besar dunia-- hasil
pengembangan para pengguna
pribadi, muncul juga kamus-kamus
istilah yang berasal dari komunitas
tertentu. Misalnya kamus istilah

dan nama untuk Komputer, Kedok-
teran, Fisika, Teknologi Informasi,
Star Trek, X-Men, juga Dragon Ball.

Pengguna korporat juga
diuntungkan dengan adanya
fasilitas ini. Seorang karyawan
perusahaan farmasi, misalnya, tidak
perlu menghafalkan semua istilah
yang digunakan pada
perusahaannya, buat saja kamus
kumpulan istilah yang sering
digunakan oleh perusahaan itu.

Versi trial 30 hari-nya bisa di-
download di situs
www.babylon.com. Banyak sekali
varian yang tersedia dengan
berbagai ukuran, biasanya berupa
program inti yang dibundel dengan
salah satu kamus bahasa yang
tersedia. Misalnya bundel program
dengan kamus English-English yang
berukuran 6,9MB (!), atau bundel
German-English-German (12,0MB),
English-French-English (8,6MB).

Tersedia juga kamus dengan
huruf yang bukan latin, misalnya
English-Japanese-English (11,3MB),
English-Chinese(Simplified)-English
(5,6MB).

Jika kemampuan download
Anda kurang mendukung,
disarankan untuk men-download
program inti tanpa bundel kamus.
Ukurannya hanya 1,9MB, tetapi
Anda harus online setiap kali
mencari istilah atau informasi.
Pilihan ini cocok untuk pengguna
kantoran yang memiliki akses
Internet. Alternatif lain adalah men-
download dengan sistem cicilan.
Programnya dulu, lalu tambahan
kamusnya sedikit demi sedikit sesuai
kebutuhan.

Untuk mereka yang memiliki
kapasitas penyimpanan yang besar,
dimungkinkan untuk menginstal
beberapa kamus sekaligus.

TIDAK HANYA KAMUS
Bagi mereka yang sering

berurusan dengan harga dan mata
uang, Babylon akan sangat
membantu. Nilai tukar akan selalu
di-update setiap kali komputer
Anda online. Klik pada angka yang
ingin Anda konversikan (Anda bisa
mengkustomisasi bagaimana cara
kerja Babylon --akan dijelaskan
kemudian), lalu secara otomatis nilai
yang Anda butuhkan keluar.

Untuk saya pribadi, yang paling
berguna tentu saja kamus istilah
komputer dan tool konversi satuan.
Segala macam satuan. Mulai dari
satuan waktu, zona waktu yang
berbeda dan waktu Internet, sampai
satuan imperial Inggris dan metrik.

Misalnya, menghitung berapa
centimeter-kah 2,5 inci? Atau

berapa rupiah-kah 348 yen?
Perhitungan yang cukup sulit
bahkan dengan adanya kalkulator
sekalipun. Karena kita harus tahu
dulu satu inci itu berapa centimeter,
ataupun satu yen itu berapa rupiah.
Belum lagi masalah nilai tukar
rupiah yang terus berubah-ubah,
membuat sulitnya mendapatkan
hasil yang akurat. Sekarang tidak
ada lagi kepusingan itu, cukup
sekali klik pada teksnya, dan semua
masalah terpecahkan.

MENDOWNLOAD DAN
MENGINSTAL

Berikut adalah semua link yang
akan Anda butuhkan untuk
memulai petualangan di dunia
Babylon.
• Program saja (harus online, atau

men-download kamus-
kamusnya) 1,9MB: http://
a1709.g.akamai.net/f/1709/2168/
7d/www.babylon.com/files/
babylon40.exe

• Bundel Program + Kamus
English-English dengan ukuran
6,9MB: http://
a1709.g.akamai.net/f/1709/2168/
7d/www.babylon.com/files/
babylon40_eng_eng.exe

• Kamus-kamus populer:
* Britannica : http://

info.babylon.com/glossaries/
87C/Britannica_com.BGL

* InterLingua : http://
info.babylon.com/glossaries/
C01/Interlingua_English.BGL

• Kamus Indonesia – Inggris /
Inggris - Indonesia:
* http://info.babylon.com/

glossaries/8C2/
Indonesian_English_
Online_Dict.BGL

* http://info.babylon.com/
glossaries/2562/
English___Indonesian_
Dictionar.BGL

* http://info.babylon.com/
glossaries/2562/
English___Indonesian_
Dictionar.BGL

• Langganan
Layanan
Tambahan
informasi cuaca
AccuWeather
(hanya online) ‡
http://info.
babylon.com/
glossaries/1C00/
accuweather_
sub.BGL

Kamus-kamus
tambahan bisa
didapat dengan
mencari pada bagian

Dictionaries & Glossaries yang
link-nya bisa ditemukan di bagian
atas situs (Gambar 1).

Karena ukuran file yang agak
sedikit gila-gilaan, disarankan untuk
mempersiapkan program pemecah
file jika Anda berencana untuk
men-download-nya dari warnet dan
mengguna-
kan
bantuan
disket.
Program
pemampat
semacam
WinZip
dan
WinRar
juga bisa
melakukan
pemecahan
file sekaligus meringkaskan
ukurannya.

Menginstal program ini dan
semua tambahan-tambahan
kamusnya semudah melakukan klik
dua kali. Semua akan secara
otomatis terinstal. Untuk
saat pertama, ia akan
bertanya mengenai
bagaimana cara kerja
Babylon yang Anda
inginkan. Saya pribadi
memilih kombinasi klik
kanan mouse dengan
tombol [Alt]. Bisa juga
lewat klik tengah mouse,
atau beberapa kombinasi
lain yang bisa dipilih.

Jika pilihan
pengaturan ini tidak
muncul, atau suatu kali
Anda ingin mengubahnya,
jendela pengaturan bisa
diakses dari klik kanan
pada ikonnya di System
Tray lalu memilih Con-
figuration (Gambar 2).
Jendela pengaturan akan
muncul dengan berbagai
pilihannya (Gambar 3).

Selama 30 hari
pertama, Anda bisa
menggunakannya secara
gratis untuk mencoba. Jika
Anda menyukai dan menganggap
program ini layak untuk dimiliki,
sekaligus menghormati Undang-
undang Hak Cipta yang baru saja

diberlakukan, silakan membeli
license (ijin penggunaan)-nya.
Untuk license sekali seumur hidup,
harga yang harus dibayar adalah
US$49,50. Sedangkan yang per
satu tahunan adalah US$24,50.
Cukup mahal memang, tetapi
layak dan sebanding dengan
kemampuannya. (Untuk mereka
yang ingin “sedikit lebih lama
mencoba” sebelum memutuskan
untuk membeli, silakan hubungi
penulis untuk triknya. Ingat, hanya
untuk mencoba dan bukan
membajak!)

MULAI MENGGUNAKAN
Dengan asumsi bahwa

program sudah terinstal dan
terpasang, Anda sudah siap
menggunakannya. Prinsip dasar
menggunakan Babylon amatlah
terlalu mudah. Anda mencari kata
yang ingin dicari padanannya,
atau nilai yang ingin dicari
konversinya, lakukan klik kanan
seraya menekan tombol [Alt] (atau

tergantung bagaimana Anda me-
milih pengaturannya) pada kata/
nilai tersebut. Babylon akan mun-
cul dengan informasi yang Anda
butuhkan (Gambar 4 dan 5).

Penggunaan yang lebih detail
akan dibahas pada kesempatan
berikutnya. Sementara itu, jika
Anda sedang browsing ke
Amazon.com misalnya, dan
menemukan barang yang Anda
inginkan dengan harga dalam
dollar Amerika dan ingin tahu
berapakah harga barang tersebut
dalam rupiah, gunakan saja
Babylon. Atau jika Anda sedang
browsing ke situs dalam bahasa
Prancis dan ingin tahu apa yang
tertulis disitu, tahu ‘kan apa yang
harus dilakukan? PC+

Gambar 1

Gambar 2

Gambar 3

Gambar 4

Gambar 5
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F.X. Bambang Irawan
fbi@e-pcplus.com

Tenggelam
dalam Nada-nada
Robbie Williams
ETERNITY

NOKIA
48* 2* 4 49 2 18 69**# 5 6(hold) 9#
288* 4 49 2 18 69**# 599 299*
4(hold) 9 49 2 18 69**# 1* 688** 5
4(hold) 99 488 4 59 68# 6(hold) 9#
1999* 4888** 4 2* 1(hold)  6(hold)
**# 699#

MOTOROLA
f2*5d2*5f2*5f1*5d1*5c2#a1g1#a0.*5d2
*5f2*5f1*5d1*5c2#a1g0*5d3*5f2.*5f1*5d1
*5c2#a1*5c1a3g3f1.f3f3g2#a3#a2.
*5c0f2f2*5d2*5c2.#a2.#a0

SAMSUNG
4 28 48 48* 28* 18 6 ^ * 5* 6 ^ **
0* 28 48 48* 28* 18 6 ^ * 5**
28**** 48 0**** 48* 28* 18 6 ^ *
18* 6**** 5**** 4* 0* 4**** 4****
5 6 ^ **** 6 ^  0**** 18** 4 4 28 18
0**** 6 ^  0**** 6 ^ **

SIEMENS
4 88 2 ^ 4 488 2 100 6 v 88 (^) 5 (v)
688 (^) 2 ^ 0000 (v) 4 488 2 100 6 v
88 (^) 588 (v) 2 ^ 0000 00 488 488 2
100 6 v 88 (^) 1 ^ (v) 6 v 0000 5
48888 40000 4 588 600 (^) 688 1 ^
8888 (v) 4 v 0000 4 2 ^ 1 6 v (^)
68888

SONYERICSSON
4 20 4 49 2 18 69000## 5 69## 2880
4 49 2 18 69000## 59 28880 49 49 2
18 69000## 10 688000 5 499 488 4
59 68## 69## 1990 488000 4 20 1
6000## 699##

FEEL
NOKIA
488* 49 088 5 49 69 0888 6888 0888
6(hold)  08 6 09 29* 0 1(hold) 8 0 08
6(hold) ** 0 59 09 49 0888 08 08
488 08 4 4(hold)  08 59 09 4 0
5(hold) 8 08 09 299 0888 08 08 08
488 0 4 0 4 0 5 0 399 69**

MOTOROLA
*5f4*5f3r4*5g3*5f2*5a1r1*5a4r4*5a4.r5
*5a4r4*6d3r4*6c4.r4r5*5a4.r5*5g3r4
*5f2r1r2r3*5f4r4*5f4*5f4.r5*5g3r4*5f3r4
*5g4.r5r4*5d2r1r2r3r4*5f4r4*5f4r4
*5f4r4*5g4r4*5e2a1

SAMSUNG
4*** 4**** 0*** 5**** 4 6* 0*
6*** 0*** 6*** 0*** 0*** 6***
0*** 28**** 0*** 18*** 0*** 0***
0*** 6*** 0*** 0*** 5**** 0*** 4
0* 0 0**** 4*** 0*** 4*** 4***
0*** 0*** 5**** 0*** 4**** 0***
5*** 0*** 0*** 0*** 2 0* 0 0****
0*** 4*** 0*** 4*** 0*** 4***
0*** 5*** 0*** 3 688*

SIEMENS
4 ^ 00 488 *00 5 488 688 *8 60000
00 *00 6 *00 6 *00 2 ^ 88 *00 100
*00 *00 6 v *00 588 *00 488 *8 * *0
40000 00 *00 4 4 *00 588 *00 4 *00
500 *00 *00 28888 *8 * *0 *00
40000 *00 4 *00 4 *00 5 *00 38888
6 v 88

SONYERICSSON
4880 49 *8 59 49 69 * 6888 * 6 *8
69 * 290 *8 1 * *8 69000 *8 599 *8
499 *9 *8 *8 48 * 4 4 *8 599 *8 49
*8 5 *8 *9 299 *9 *8 *8 *8 4 * 4 * 4
* 5 * 399 69000

MILLENNIUM

NOKIA
68*# 68 6# 69 58 6 599 4 58# 58 5#
59 48 5 499 2# 68# 68 6# 69 58 6
599 4 58# 58 5# 59 48 5 499 2#

MOTOROLA
#a2a3#a3a2g3a3g1f1#g2g3#g3
g2f3g3f1#d1#a2a3#a3a2g3a3
g1f1#g2g3#g3g2f3g3f1#d1

SAMSUNG
6 ^  6**** 6 ^ **** 6 5**** 6****
5* 4* 5 ^  5**** 5 ^ **** 5 4****
5**** 4* 2 ^ * 6 ^  6**** 6 ^ ****
6 5**** 6**** 5* 4* 5 ^  5**** 5 ^
**** 5 4**** 5**** 4* 2 ^ *

SIEMENS
6 88 (^) 600 (v) 6 (^) 688 (v) 500 6
58888 4 500 (^) 500 (v) 5 (^) 588 (v)
400 5 48888 2 (^) 600 600 (v) 6 (^)
688 (v) 500 6 58888 4 500 (^) 500 (v)
5 (^) 588 (v) 400 5 48888 2 (^)

SONYERICSSON
6## 68 6## 69 58 6 599 4 58## 58
5## 59 48 5 499 2## 68## 68 6## 69
58 6 599 4 58## 58 5## 59 48 5 499
2##

ROAD TO MANDALAY

NOKIA
48** 49 4 3 2 4 3 1(hold)  18 19 1 1
2 6** 6* 5** 6 68 699 688 69# 58
699 09 188* 4 49 4 3 2 4 3 1(hold)
18 19 1 1 2 6** 5* 5** 58 59* 5**
58 69* 48** 599

MOTOROLA
*5f4*5f3*5f3*5e3*5d3*5f3*5e3*5c3.
*5c4*5c3*5c3*5c3*5d3a3*5a3g3a3a
4a2a4#a3g4a2r2*5c4*5f4*5f3*5f3
*5e3*5d3*5f3*5e3*5c3.*5c4*5c3*5c3
*5c3*5d3a3*5g3g3g4*5g3g3g4
*5a3f4g2

SAMSUNG
48*** 48**** 48**** 38****
28**** 48**** 38**** 18**** 0***
18*** 18**** 18**** 18****
28**** 6**** 68**** 5**** 6****
6*** 6 6*** 6 ^ **** 5*** 6 0
18*** 48*** 48**** 48****
38**** 28**** 48**** 38****
18**** 0*** 18*** 18**** 18****
18**** 28**** 6**** 58**** 5****
5*** 58**** 5**** 5*** 68****
4*** 5

SIEMENS
4 ^ 00 488 4 3 2 4 3 1 100 188 1 1 2
6 v 6 ^ 5 v 6 600 68888 60000 688
(^) 500 (v) 68888 * 1 ^ 0000 4 488 4
3 2 4 3 1 100 188 1 1 2 6 v 5 ^ 5 v
500 5 ^ 88 5 v 500 6 ^ 88 4 v 00
58888

SONYERICSSON
4880 49 4 3 2 4 3 1 18 19 1 1 2 6000
60 5000 6 68 699 688 69## 58 699 *
1880 4 49 4 3 2 4 3 1 18 19 1 1 2
6000 50 5000 58 590 5000 58 690
48000 599

ROCK DJ
NOKIA
18** 2 2 2 39 2 0 08 2 28 79** 09
18* 2 4# 6 7 3 3 29 28 09 1 2 2 2 39
2 08 08 2 48# 4# 09 0 1 2 4 3 2 2 08
29 2

MOTOROLA
*5c3*5d3*5d3*5d3*5e2*5d2r2r3*5d2
*5d3b2r2*5c3*5d3*5#f3*5a3*5b3*5e3
*5e3*5d2*5d3r1*5c3*5d3*5d3*5d3*5e2
*5d2r2r3*5d2*5#f3*5#f3r2r2*5c3*5d3
*5f3*5e3*5d3*5d3r3*5d2*5d2

SAMSUNG
18**** 28**** 28**** 28**** 38
28 0 0**** 28 28**** 7 0 18****
28**** 4 ^ 8**** 68**** 78****
38**** 38**** 28 28**** 0*
18**** 28**** 28**** 28**** 38
28 0 0**** 28 4 ^ 8**** 4 ^ 8**** 0
0 18**** 28**** 48**** 38****
28**** 28**** 0**** 28 28

SIEMENS
1 ^ 2 2 2 388 2 * *0 2 200 7 v 88 * 1
^ 00 2 4 (^) 6 (v) 7 3 3 288 200 *8 1
2 2 2 388 2 * *0 2 400 (^) 4 * * 1 (v)
2 4 3 2 2 *0 288 2

SONYERICSSON
180 2 2 2 39 2 * *8 29 28 79000 *
180 2 4# 6 7 3 3 29 28 *99 188 2 2 2
39 2 * *8 29 48# 4# *9 * 18 2 4 3 2 2
* 29 2

SHE’S THE ONE
NOKIA
68* 7 199*# 0 688** 7 199*# 3888
49# 3 1# 79** 7 08 48# 1* 79**
19*# 188# 6** 699 09

MOTOROLA
a2b2*5#c0r1a2b2*5#c0*5e3*5#f2
*5e2*5#c2b1b1r2#f2*5c2b1
*5#c0*5#c2a2a0r1

SAMSUNG
6 7 1 ^ 8** 0* 6 7 1 ^ 8** 38**** 4
^ 8 38 1 ^ 8 7* 7* 0 4 ^  18 7* 1 ^
8** 1 ^ 8 6 6** 0*

SIEMENS
6 88 7 1 ^ 8888 (^) *8 6 v 0000 (v) 7
1 ^ 8888 (^) 30000 00 488 (^) 3 1 (^)
7 v 88 7 * 400 (^) 1 ^ (v) 7 v 88 1 ^
88 (^) 10000 6 v (v) 68888 *8

SONYERICSSON
6 7 1990# *8 68000 7 1990# 3888
49# 3 1# 79000 7 *8 4# 10 79000
190# 188# 6000 699 *8

SOMETHING
BEAUTIFUL

NOKIA
1* 1 29* 1 68** 6 6 59 69 0 188 1
29* 18 0 6** 5 0 1 1 6 0 09 5 08 09
6# 6# 1* 68** 5 29 6 5 0 5 6 69 59
08 188 1 29* 1 68** 6 6 59 69 0 188
1 29* 18 0 6** 5 0 1 1 6 0 09 5 08 09
6# 6# 1* 68** 5 29 6 5 0 5 6 69 59

MOTOROLA
*5c2*5c2*6d1*6c1*5a2*5a2*5a2*5g1
*5a0r2*5c2*5c2*6d1*6c2r2*5a2
*5g2*50r2 *5c2*5c2*5a2r2r1
*5g2r2r1 *5#a2*5#a2*6c2*5a3
*5g3*61*5d2*5a2*5g2r1*5g2*5a2
*5a1*5g0r2 *5c2*5c2*6d1*6c1
*5a2*5a2*5a2*5g1*5a0r2*5c2
*5c2*6d1*6c2r2*5a2*5g2*50r2
*5c2*5c2*5a2r2r1*5g2r2r1
*5#a2*5#a2*6c2
*5a3*5g3*61*5d2*5a2*5g2r1
*5g2*5a2*5a1*5g0

SAMSUNG
1 1 28* 18* 6 6 6 5* 6** 0 1 1 28*
18 0 6 5 0 1 1 6 0 0* 5 0 0* 6 ^  6 ^
18 6**** 5**** 2 6 5 0* 5 6 6* 5**

0 1 1 28* 18* 6 6 6 5* 6** 0 1 1 28*
18 0 6 5 0 1 1 6 0 0* 5 0 0* 6 ^  6 ^
18 6**** 5**** 2 6 5 0* 5 6 6* 5**

SIEMENS
1 88 1 2 ^ 88 1 6 v 00 6 6 588 688 *
10000 1 2 ^ 88 100 * 6 v 5 * 1 ^
0000 1 6 * *8 5 * *8 6 (^) 6 1 ^ (v) 6
v 00 5 2 v 00 6 5 *8 5 6 688 588 *
10000 1 2 ^ 88 1 6 v 00 6 6 588 688
* 10000 1 2 ^ 88 100 * 6 v 5 * 1 ^
0000 1 6 * *8 5 * *8 6 (^) 6 1 ^ (v) 6
v 00 5 2 v 00 6 5 *8 5 6 688 588

SONYERICSSON
10 1 290 1 68000 6 6 59 69 *88 1 1
290 18 * 6000 5  *000 10 1 6 * *9 58
* *9 68## 6## 10 68000 5  29 6 5 *9
58 6 69 59 *88 1 1 290 1 68000 6 6
59 69 *88 1 1 290 18 * 6000 5  *000
10 1 6 * *9 58 * *9 68## 6## 10
68000 5  29 6 5 *9 58 6 69 59

SUPREME
NOKIA
28** 39 49 488 39 29 288 6** 5 699
588 6 6 5 699 288* 39 49 488 39 29
288 6** 5 699 588 69 58 699 588 6 6
5 699

MOTOROLA
*5d2*5e1*5f0*5f2*5e1*5d0*5d2a2g2a0
g2a2a2g2a0*5d2*5e1*5f0*5f2*5e1*5d0
*5d2a2g2a0g2a1g2a0g2a2a2g2a0

SAMSUNG
28 38* 48** 48 38* 28** 28 6 5 6**
5 6 6 5 6** 28 38* 48** 48 38* 28**
28 6 5 6** 5 6* 5 6** 5 6 6 5 6**

SIEMENS
2 ^ 88 388 488 40000 388 288 20000
6 v 5 68888 50000 6 6 5 68888 2 ^
0000 388 488 40000 388 288 20000
6 v 5 68888 50000 688 500 68888
50000 6 6 5 68888

SONYERICSSON
20 39 49 488 39 29 288 6000 5 699
588 6 6 5 699 2880 39 49 488 39 29
288 6000 5 699 588 69 58 699 588 6
6 5 699

Catatan:
Semua ringtone disajikan
dalam bentuk keypress.
Artinya, urutan karakter
yang ditampilkan di atas
bisa langsung dipencet ke
tombol-tombol ponsel. Bisa
jadi output yang keluar di
layar akan berbeda dengan
input yang Anda masukkan
di keypad. PC+
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fbi@e-pcplus.com Menyisir dan Membuat

Situs WAP di TagTag
Apa kabar WAP

(Wireless Access Pro-
tocol)? Memang

layanan satu ini agak
dilupakan, namun

sebenarnya ia sangat
bermanfaat.

Terutama bagi yang
sudah punya akses

GPRS dan butuh
informasi atau stuff

dari Internet.

anya saja, orang
kadang tidak tahu
kemana harus menuju.
Tidak seperti alamat-

alamat alias URL Internet yang
sudah banyak dihapal luar kepala
oleh penggunanya yang sudah
bejibun, alamat WAP tidak
banyak dikenang. Kecuali oleh
pengguna fanatik yang
memerlukannya. Apakah Anda
dengan segera dapat menjawab
ketika diminta menyebut lima
situs WAP yang berasal dari tanah
air?

Keberadaan situs WAP juga
tidak banyak dibahas oleh media
maupun obrolan lisan. Jadi
lengkaplah sudah nasib
ketidakpopuleran protokol ini.

ONE STOP SHOP
Bagi pengguna ponsel yang

mempunyai kapabilitas untuk
mengakses WAP, layanan WAP ini
akan sangat membantu ketika
sedang tidak bisa mengakses PC
berikut Internetnya. Meski
terbatas, WAP bisa menampilkan
isi perut Internet di ponsel. Jadi
kalau kepepet, WAP bisa jadi
dewa penyelamat. Sayangnya, pas
ketika membutuhkan,
kemungkinan besar kita tidak
tahu ke WAP mana kita harus
mengayuh perahu kita.

Ada sebuah “one stop shop”
yang lumayan menarik untuk
dikunjungi bagi “praktisi” WAP:
TagTag (www.tagtag.com).
Fungsi utama layanan WAP ini
adalah sebagai direktori bagi
ribuan situs WAP yang ada. Untuk
kepentingan ini, Tagtag
menyuguhkan sentuhan manis
agar kita mendapatkan
gambaran situs sebenarnya
dengan menyediakan sebuah
emulator WAP.

Fungsi yang nomor dua
adalah bahwa kita bisa hosting
dan membuat situs WAP pribadi
kita pada situs ini. Situs-situs
pribadi ini pulalah yang menjadi
basis direktori yang dirujuk oleh
TagTag. Situs yang kita bikin akan
mendapat alamat
wap.tagtag.com/
namadomain.

Selain itu, TagTag juga
menyediakan hosting untuk e-
mail gratis. Dengan
menggunakan e-mail ini, kita bisa
mengecek e-mail melalui ponsel
WAP.

SITUS WAP PRIBADI
TagTag menyiapkan langkah

mudah kalau kita ingin memiliki
sebuah situs WAP. Pertama, kita
harus mendaftar untuk
mendapatkan user ID dan

menentukan password untuk login.
Keduanya kita butuhkan untuk
mengelola account kita di Tagtag.

Setelah mengantongi account
tersebut, kita bisa membuat situs
sendiri. Caranya sederhana. Cukup
login dan sesudah berada dalam
halaman My TagTag kita akan
diberi beberapa pilihan, yaitu
Account settings (untuk mengelola
username, password, dan e-mail),
WAPMAIL settings (mengelola e-
mail account), Add new WAP site

(untuk membuat situs WAP).
Pilih Add new WAP site. Kita

akan diminya mengisi beberapa
kolom untuk memberi nama,
deskripsi, kata kunci pencarian, dan
kategori untuk situs yang kita buat.
Setelah beres, kita akan dibawa
masuk ke halaman untuk
menyunting situs. Di sini kita bisa
menambahkan teks atau gambar.
Sebagai catatan, kita bisa
mempunyai lebih dari satu situs di
TagTag.

DIREKTORI
Fungsi ini harus

ditonjolkan karena
sangat membantu
para peselancar
WAP. Kita bisa
melakukan search
atas belasan
kategori yang
tersedia. Untuk
mendapatkan situs yang
menyediakan software untuk
ponsel 3650, misalnya, ketik saja

software 3650 pada kolom
pencarian.

Entri hasil pencarian bisa
diklik, dan emulator browser akan

menampilkan isi situs
sesuai dengan apa yang
akan tampil pada ponsel
kita. Cara ini sangat
membantu jika kita ingin
melihat gambaran isi situs
WAP tanpa
menginginkan pulsa kita
jebol karenanya. Kita bisa
intip dulu di Internet.

Baru setelah apa
yang kita mau kira-kira
ada di situ, kita bisa
menyelaminya lebih jauh
dengan ponsel kita. Ini

berlaku terutama kalau kita ingin
men-download peranti lunak atau
content untuk ponsel. PC+

H
Emulator WAP
browser untuk
mengintip isi situs.
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Windows 9x: Menonaktifkan
Opsi Restart ke MS-DOS

Menonaktifkan Task Manager

Memunculkan Fitur DVD pada
Windows Media Player

Jika beberapa edisi lalu kita membahas mengenai bagaimana cara menonaktifkan
MS-DOS, kali ini kita akan mempelajari bagaimana jika kita ingin menonaktifkan opsi
restart ke MS-DOS. Sebuah opsi yang memungkinkan Anda untuk masuk ke mode DOS
murni melalui menu shut down di Windows yang biasa dapat diakses melalui
[Start]>[Shutdown...].

Bukankah pada trik edisi 137 lalu opsi ini juga akan dinonaktifkan? Jadi apa bedanya
dengan beberapa edisi yang lalu? Bedanya, pada trik kali ini kita hanya akan
menonaktifkan mode DOS murninya saja, sedangkan MS-DOS prompt di Windows tetap
dapat diakses seperti biasa. Untuk mengaplikasikan trik ini, ikuti langkah-langkah berikut:
1. Jalankan Registry Editor Anda dengan mengklik [Start]>[Run] lalu ketik regedit.
2. Masuklah ke subkey

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies.
3. Buat sebuah subkey baru dengan cara mengklik kanan mouse pada bagian kanan

window, kemudian pilih [New]>[Key].
4. Beri nama subkey yang baru Anda buat tadi dengan nama WinOldApp.
5. Buat DWORD Value baru dengan nama NoRealMode. Caranya klik kanan mouse lalu

pilih [New]>[DWORD value].
6. Klik dua kali DWORD value tadi kemudian isikan Value Data-nya dengan angka 1.
7. Tutup Registry Editor, kemudian restart PC Anda.

Kembali kami mengingatkan Anda untuk membackup registry sebelum mengeditnya,
agar Anda dapat kembali ke setting sebelumnya apabila terjadi kesalahan dalam
pengeditan.

Steven Andy Pascal
steven@e-pcplus.com

Task Manager merupakan sebuah fitur standar yang sudah terintegrasi dalam berbagai versi
Windows yang berbasis NT, seperti Windows NT, 2000 dan XP. Fungsinya adalah untuk menginformasikan
proses dan aplikasi yang sedang bekerja, mengubah prioritas, menampilkan informasi performa PC, dan
masih banyak lagi.

Dengan menonaktifkan Task Manager, maka saat user menekan [Ctrl]+[Alt]+[Del] maka akan muncul
peringatan Task Manager has been disabled by your administrator dan fitur tersebut tidak akan
dapat diakses. Demikian pula jika pengguna mengklik kanan mouse di taskbar, opsi Task Manager akan
di redupkan serta tidak dapat diklik.

Langsung saja, ikuti langkah-langkah berikut ini untuk menonaktifkannya:
1. Klik [Start]>[Run...] kemudian ketik regedt32 untuk menjalankan Registry Editor.
2. Masuk ke key

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\System.
3. Jika subkey System belum ada, Anda dapat membuatnya dengan mengklik [Edit]>[New]>[Key]

kemudian beri nama System.
4. Buat DWORD value baru dengan mengklik kanan mouse pada bagian kanan window kemudian pilih

[New]>[DWORD value], dan beri nama DisableTaskMgr.
5. Klik DWORD value bernama DisableTaskMgr tadi kemudian isikan value datanya dengan nilai 1.
6. Tutup Registry Editor kemudian log off atau restart Windows Anda.

Apabila sewaktu-waktu Anda ingin mengaktifkan kembali Task Manager, Anda dapat mengubah
value data DisableTaskMgr dengan nilai 0 atau langsung hapus DWORD valuenya. Sebagai catatan,
trik ini hanya dapat bekerja pada Windows NT, 2000 dan XP. Selamat mencoba.

Steven Andy Pascal
steven@e-pcplus.com

Mungkin ada di antara Anda yang belum tahu kalau sebenarnya Windows Media
Player dari Windows sudah bisa untuk menampilkan DVD. Untuk mengaktifkannya
ikuti langkah-langkah berikut ini:
1. Buka Registry Editor, dan masuk ke key

HKEY_CURRENT_USER\Software\Microsoft\MediaPlayer\Player\Settings.
2. Klik kanan pada panel sebelah kanan dan pilih [New]>[String Value].
3. Beri nama String Value tersebut dengan nama EnableDVDUI.
4. Klik dua kali String Value tersebut, dan isi Value Data-nya dengan yes.

Sekarang jalankan Windows Media Player Anda, klik menu [File] di bawahnya
akan terdapat pilihan Open DVD. Sekarang Windows Media Player Anda punya
kemampuan untuk menampilkan DVD.

Yang perlu dicatat, hal ini akan berfungsi apabila Anda memiliki DVD drive pada
komputer. Bagi yang tidak memasang peranti tersebut, jelas saja tidak bisa
menampilkan DVD. Selamat mencoba.

Fadlan Setiaji
aji-edl@plasa.com
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Membuat “Splash Screen”
pribadi di Excel

Membuat Efek Metalik
pada Pipa dan Kawat

Pada tutorial ini kita akan belajar membuat efek metalik pada pipa dan kawat. Cara-caranya
tidak terlalu susah. Hanya dibutuhkan sedikit kesabaran. Oke deh, kita mulai saja. Ikuti saja langkah-
langkah di bawah ini.

Langkah pertama, buatlah sebuah media gambar baru sebesar 250x250 pixel. Pilih warna abu-
abu gelap sebagai warna foreground (depan). Buat layer baru, kemudian dengan tool [Pencil] atau
[Paintbrush], buatlah bentuk garis kawat dengan tebal 15 pixel (gambar 1). Namakan layer baru
tersebut menjadi Wire.

Langkah kedua, buat copian dari layer Wire, dengan men-drag ke layer baru (tombol Create a
new layer). Dobel klik pada layer dan ubah nama menjadi Cut Wire. Sembunyikan layer asli Wire
dengan mengklik pada icon mata pada jendela Layers. Gunakan layer tersebut nanti. Sekarang, pilih
[Eraser tool], set ukuran brush sekitar 5 pixel dan potong garis seperti Gambar 2.

Langkah ketiga, tekan [Ctrl] dan klik pada layer Wire yang tersembunyi pada jendela Layers. Ini
akan membuat seleksi luar pada layer Wire transparasinya. Selanjutnya ke jendela Channels dan
simpan seleksi sebagai channel. Pilih channel baru pada jendela Channels, lalu dobel klik dan ubah
nama menjadi Wire Bevel.

Langkah keempat, lakukan Gaussian Blur pada seleksi dengan 9 pixel, lalu 6 pixel, lalu 3 pixel,
dan terakhir 1 pixel. Lakukan Auto Levels [Ctrl]+[Shift]+[L] pada seleksi. Lalu kembali ke jendela
Layers, tekan [Ctrl] dan klik layer Cut Wire untuk memilih transparasi. Kembali ke jendela Chan-
nels, klik pada [Wire Bevel], tekan D untuk me-reset warna, invert seleksi [Ctrl]+[Shift]+[I] dan
terakhir bersihkan seleksi dengan menekan Del. Lakukan deselect [Ctrl[+[D].

Langkah kelima, kembali ke jendela Layers dan pilih layer Cut Wire. Klik
[Filter]>[Render]>[Lighting Effects...]. Buat warna putih arah datang sinar dan mengarah ke bawah,
dari atas. Lalu, buat warna biru arah sinar datang, menyinari ke atas, dari bawah.

Atur setting Properties menjadi:
Gloss :  100(Shiny)
Material : -100(Plastic)
Exposure : -39
Ambiance : -21

Set Texture Channel menjadi Wire Bevel dan height menjadi 15. Sekarang paskan posisi arah
datang sinar agar sesuai.

Langkah keenam, klik pada layer yang tersembunyi Wire layer untuk memperlihatkan kembali.
Klik lagi pada layer [Ctrl], untuk membuat seleksi. Untuk membuat garis menjadi lebih kecil 1 pixel,
invert seleksi dengan menekan [Ctrl]+[Shift]+[I], lalu klik [Select]>[Modify]>[Expand...] 1 pixel dan
bersihkan seleksi dengan menekan [Del] dan Deselect [Ctrl]+[D]. Klik [Filter]>[Render]>[Lighting
Effects...]. Dan set Texture Channel menjadi Wire Transparency. Klik [OK] dan buat dropshadow.
Maka hasil akhirnya akan seperti Gambar 3.

Andhi Irawan
andhiirawan@hotmail.com

Gambar 1

Gambar 2

Gambar 3

Splash screen adalah tam-
pilan grafis yang muncul meng-
awali suatu program yang diak-
tifkan, biasanya memuat logo
dan informasi singkat mengenai
program tersebut. Splash screen
hanya muncul beberapa detik
dan kemudian secara otomatis
akan kembali hilang.

Nah, untuk sedikit memberi
kesan yang menarik pada
lembaran kerja yang Anda buat
di Excel (workbook) ada baiknya
Anda membuat splash screen
pribadi, hal ini akan membuat
workbook Anda lebih spesial dan
menarik perhatian orang lain.

Trik ini disarankan bagi
Anda yang mengetahui macro
pada aplikasi MS Excel dan
mempunyai kemampuan dasar
tentang VBA (Visual Basic For
Application). Bagaimana cara
membuatnya?
1. Buat workbook Anda seperti

biasanya. Saya sarankan
jangan menyimpan dan
memberi nama file terlebih
dahulu atau kalau mau
menyimpan biarkan nama
file-nya standar yaitu
book1.xls.

2. Aktifkan Visual basic
editor (VBE) dengan

menekan [Alt]+[F11] atau
klik [Tools]>[Macro]>[Visual
Basic editor]. Buatlah
sebuah form dengan cara
mengklik
[Insert]>[UserForm]. Klik
form yang baru muncul.
Perhatikan judul form
tersebut adalah
UserForm1. Kita perlu
mengadakan beberapa
perubahan, ubah Caption
sesuai keinginan Anda
untuk merubah judulnya.
Ubah Name menjadi
AWAL. Untuk mengubah
itu semua, Anda dapat
lakukan di jendela Proper
ties pada bagian kiri bawah
VBE. Ingat, langkah ini
harus Anda lakukan dengan
benar karena akan
berpengaruh pada langkah
berikutnya .

3. Selanjutnya masukan teks
yang ingin Anda tampilkan
kedalam form tersebut, klik
label yang terlihat sebagai
icon dengan huruf A besar
pada Toolbox. Jika toolbox
belum tampil, klik
[View]>[Toolbox]. Lalu klik
ke dalam form. Kemudian
ganti Caption-nya pada

jendela Properties, misal Hallo
Semua. Masukkan lagi satu
label di bawah yang pertama
dan ubah Caption-nya menjadi
Selamat Menggunakan
Excel. Ubah ukuran hurufnya
sesuai keinginan Anda dengan
mengklik Font pada jendela
Properties. Pengaturan dapat
Anda lakukan seperti mangatur
wordart dalam aplikasi Office.

4. Setelah semua selesai kini
saatnya membuat beberapa
kode program untuk
menjalankan splash screen
tersebut. Kembali ke layar VBE,
klik dua kali Thisworkbook
dengan icon X besar yang
berada pada jendela Project-
VBA project dibagian kiri atas
layar, kemudian ketik:
Private Sub
Workbook_Open()
AWAL.Show
End Sub

5. Kemudian masukkan subroutine
berikut dengan cara klik dua

kali pada form AWAL dan pilih
procedure Activate, atau ketik
kode berikut:
Private Sub
UserForm_Activate()
Application.OnTime Now +

TimeValue("00:00:05"),
"TUTUP"
End Sub

6. Terakhir masukan sebuah
Module normal dengan cara
klik [Insert]>[Module] lalu
ketik :
Private Sub TUTUP()
Unload AWAL
End Sub

7. Untuk mencoba sekarang
kembali klik dua kali pada
form AWAL yang ada pada
Jendela Project-VBA project
dibagian kiri atas layar, lalu
klik [Run]>[Run Sub/
UserForm] atau tekan [F5].

8. Bagaimana cara kerjanya?
Ketika workbook yang Anda
punya, yaitu book1.xls
dijalankan, maka langkah 4
akan dieksekusi. Ketika form
AWAL muncul atau aktif,
maka langkah 5 dijalankan.
Form hanya akan muncul
selama 5 detik (waktu dapat
Anda ubah sesuai selera),
setelah itu maka subroutine
TUTUP akan dijalankan
untuk menutup form AWAL.
Splash screen ini hanya

akan jalan pada workbook yang
Anda simpan saja yaitu
book1.xls.

Budiman
Ibnu_78@yahoo.com
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Alex Pangestu
alex@e-pcplus.com Microsoft Office

System Beta 2 Kit 2003

S

Yang dilakukan oleh
tim sepak bola untuk

menyambut musim
kompetisi baru

biasanya adalah
mendatangkan

pemain baru,
menyiapkan strategi

baru, atau
menyediakan kostum

baru agar dapat
bersaing dengan tim

lain.

udah sekitar
2 tahun, sejak
Office XP, Microsoft
tidak meluncurkan

Office baru. Tapi mungkin tidak
lama lagi Office 2003 akan
diluncurkan. Mengapa? Karena
Microsoft gencar menyebarkan
Office 2003 versi beta, yang
disebut Microsoft Office System
Beta 2 Kit 2003. Versi beta
pertama, yang bernama Office
11 Beta 1, dikenalkan bulan
Desember 2002. Kabarnya,
bulan September atau Oktober
mendatang versi resminya
sudah beredar di pasaran.

PCplus mencoba Microsoft
Office System Beta 2 Kit 2003. Isi
paket sistem Office ini tak
tanggung-tanggung. Ada 12 CD
yang berisi Office 2003, 2 CD
language pack, Publisher 2003,
FrontPage 2003, InfoPath 2003,
Windows Server 2003, Share-
Point Services, SharePoint Portal
Server v2.0, Outlook 2003,
Exchange Server 2003 dan One-
Note 2003. Di samping itu ada
sebuah CD demo, CD evaluation
dan CD developer source.

Jika Office 2003 diinstal ke
PC yang sudah ada Office versi
lain, setup akan menanyakan
apakah kita akan meng-
upgrade atau menginstal baru.
Kalau instal baru yang dipilih,
kita akan ditanya apakah Office
yang lama tetap disimpan atau
tidak. Yang disimpan atau yang
dibuang bisa dipilih sesuai
keinginan kita. Selesai instalasi,
PC tidak perlu di-reboot.

Office 2003 memiliki
tampang standar Office.
Artinya, nggak berbeda jauh
dengan Office versi sebelumnya,
khususnya Office XP. Hanya saja
Office 2003 lebih memiliki icon-
icon yang lebih colorful dan
icon baru yaitu [Permission].

Kostum Baru
[Permission] adalah salah

satu fitur baru untuk Office, di
mana seorang pembuat doku-
men dapat mengatur siapa-
siapa saja yang dapat meng-
utak-atik dokumen, mulai dari
membuka, mengedit, mengirim-
kannya melalui e-mail atau
lainnya. Untuk dapat menggu-
nakan fitur ini, pengguna Office
harus menginstal software klien
Windows Rights Management
(WRM) pada Windows Server
2003. Pengaturan proteksi
dokumen menggunakan
teknologi baru yang bernama
Information Rights Manage-
ment (IRM).

Home user yang tidak
memiliki Windows Server 2003
namun ingin menggunakan IRM,
dapat menggunakan layanan
online dari Microsoft. Sampai
sekarang, layanan ini masih
bersifat time-trial. Artinya, dalam
jangka waktu tertentu
layanannya habis.

Ada beberapa fungsi
menarik yang bisa dihasilkan oleh
IRM. Salah satunya adalah
mengatur siapa saja yang bisa
membuka file dokumen. Yang
bisa membuka pun masih diatur
lagi ngapain mereka. Ada yang
cuma bisa membuka namun tidak
bisa mengedit, ada yang bisa
membuka dan mengedit dan
lain-lain. Bahkan dengan tombol
[Print Screen] pada keyboard
pun tak mampu menangkap isi
dokumen. Namun dengan
aplikasi penangkap layar, isi
dokumen tetap dapat ditangkap.
Selain itu, bisa pula diatur agar

dokumen hanya bisa dicetak
dalam jumlah tertentu,
memberikan tanggal basi (expiry
date), menyebarkan dokumen
melalui e-mail dan fungsi-fungsi
lain.

Word dan Excel memiliki
sebuah fitur untuk mengunci
format sebuah dokumen. Jadi
seolah-olah dokumen yang
dibuat dengan Word atau Excel
sudah memiliki template. Dengan
demikian, perusahaan atau
seseorang yang ingin memiliki
format yang sama atau tidak jauh
berbeda, dapat melakukannya
tanpa perlu repot-repot
mengostumasi setiap kali
membuat dokumen.

Seluruh aplikasi Office 2003
dapat membuat dokumen XML
(Extensible Markup Language)

dan menggunakan XML untuk
sharing data dan dokumen. XML
sendiri adalah bahasa yang dapat
digunakan untuk berbagi
informasi di Internet, intranet
atau jaringan lain dengan tingkat
kompabilitas yang tinggi dengan
aplikasi, jaringan struktur data
serta sistem operasi. Untuk
pengguna rumahan, fitur XML ini
kurang berguna. Namun bagi
perusahaan yang tergantung
pada XML untuk pembagian data
atau dokumen, penambahan
fitur ini merupakan bala
bantuan. Sharing data dan
dokumen dengan XML ditopang
dengan InfoPath, yang juga
menjadi bagian dari Office
System.

Pemain Lama
“Pemain inti” Office 2003

adalah Word, Excel, Access,
PowerPoint dan Outlook. Selain
Outlook, Word, Excel, Access

dan PowerPoint tidak
mengalami perubahan yang
signifikan. Namun seluruh
“pemain inti” ini diberikan
kemampuan baru seperti XML,
IRM dan pembuatan template.
Perubahan pada PowerPoint
tampak pada efek animasi
baru, diagram organisasi, panel
Task, penggunaan suara, serta
fitur recovery. Sedangkan
Access 2003 dibundel dengan
MSDE 2000 SP3 yang
memungkinkan pembuatan
server berbasis SQL.

Perubahan paling
signifikan terdapat pada
Outlook.  Dari tampangnya saja
sudah berbeda dari versi
sebelumnya. Panel untuk
membaca (reading pane) pada
Outlook 2003 mampu memuat

isi pesan lebih banyak. Inter-
face-nya sekarang terdiri dari
kolom-kolom.

Itu baru tampangnya. Fitur-
fitur Outlook turut ditambah.
Outlook 2003 kini memiliki
fungsi untuk menyaring spam
atau junk mail. Saringan milik
Microsoft ini tidak
menggunakan teknik matching
yang sederhana, tapi juga
menganalisa isi e-mail. Fitur
yang diberi kemampuan baru
adalah fitur kalendar. Outlook
2003 mendukung penyimpanan
kalendar dalam bentuk
halaman web. Opsi-opsi untuk
kalendar pun ditambah, seperti
untuk kostumasi dan
sebagainya.

Selain pemain inti, pemain
lainnya adalah FrontPage 2003
yang juga tidak terlalu signifikan
perubahannya. FrontPage 2003
sekarang memiliki lebih banyak
integrasi dengan tool-tool grafis

luar. Editor untuk coding pun
sekarang lebih baik.

Pemain Baru
Pemain-pemain baru

ditambahkan oleh Microsoft
pada Office System 2003 ini.
Mereka adalah OneNote 2003
dan InfoPath 2003. InfoPath 2003
sebenarnya tidak baru-baru
amat. Microsoft memiliki aplikasi
yang fungsinya hampir sama
dengan InfoPath 2003, yaitu
XDocs.

OneNote 2003
Aplikasi ini merupakan

aplikasi baru yang merupakan
bagian dari Office System 2003.
OneNote adalah semacam kertas
buram virtual dengan fungsi-
fungsi mengetik standar yang

dapat ditemui di Word, plus
tabulasi dan halaman.
Pembuatan OneNote ini
tampaknya memperhatikan
kebiasaan orang dalam
membuat catatan.

Daripada kertas-kertas kecil
berserakan di sekitar meja, lebih
baik diorganisir dengan
OneNote.

Tidak berbeda dengan
kertas buram aslinya, OneNote
dapat “dicorat-coret”. Jadi
tidaknya hanya menulis
berbagai catatan dengan cara
mengetik, tapi kita juga bisa
menulis dan menggambar
dengan menggunakan mouse.
Juga, OneNote dapat merekam
suara.

Catatan penting bisa
diberikan mark atau penanda.
OneNote akan membuat
rangkuman catatan-catatan
berdasarkan penanda sehingga
kita dengan mudah dapat
melakukan pencarian. Bahkan
suatu catatan dapat langsung
dikirimkan ke e-mail melalui
OneNote.

InfoPath 2003
InfoPath adalah suatu tool

yang merupakan bagian dari
Office System 2003 yang
digunakan untuk mengorganisir
data yang berbasis XML. Tidak
seperti aplikasi-aplikasi lain di
Office System 2003, InfoPath
hanya mengerti XML dalam
format aslinya, yaitu dengan
tag-tag.

Jika sebuah dokumen
disimpan dalam bentuk XML,
InfoPath dapat membuat
aplikasi untuk form yang
nantinya digunakan untuk
memasukkan data, mengakses
data, menciptakan laporan,
tanpa harus mempelajari XML
secara khusus. Para pengguna
juga tidak perlu khawatir
masalah kompabilitas, karena
XML merupakan bahasa yang
sangat umum.

Kesimpulan
Fitur-fitur baru yang

ditambahkan atau fitur-fitur
lama yang dikembangkan
tampaknya berorientasi pada
pelanggan korporat atau
perusahaan. Home user
mungkin akan jarang
menggunakan XML untuk
berbagi data, home user
mungkin jarang menggunakan
aplikasi e-mail macam Outlook,
dan home user, apalagi yang PC-
nya jarang digunakan orang
lain, mungkin jarang pula
memberikan proteksi ke
dokumennya.

Jadi, apakah home user
perlu meng-upgrade Office
mereka? Kita lihat saja nanti
versi beneran-nya. Siapa tahu
ada fitur-fitur yang menarik
untuk digunakan. PC+

Word 2003 tidak mengalami perubahan yang signifikan. Begitu juga dengan aplikasi inti
lainnya. Perubahan yang signifikan dapat dilihat pada Outlook 2003.
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Memastikan Sistem
Dual Channel

I

Silvester Sila Wedjo
sila@e-pcplus.com

Era sistem PC berbasis
dual channel memory

benar-benar tengah
dalam posisi puncak.

Dengan hadirnya
chipset-chipset

terbaru beberapa
bulan terakhir,

teknologi dual chan-
nel pada memori
double data rate
dipastikan terus-

menerus mendapat
angin.

ni bisa dimaklumi
mengingat teknologi
single channel yang
sudah umum

digunakan pada sistem berbasis
SDRAM maupun DDR memang
kurang dapat memenuhi tuntu-
tan penggunanya akan band-
width yang besar dari memori.
Akibat-nya bisa ditebak. Ke-
mampuan yang bisa dihasilkan
tidak bisa digenjot lebih maksi-
mal lagi. Padahal potensi ke
arah itu sangat terbuka lebar.
Dan hadir-nya teknologi dual
channel pada memori DDR se-
akan memberi angin segar buat
mereka yang mendambakan
performa maksimal.

Teknologi dual channel
pada sistem berbasis DDR ke-
mudian diketahui mampu me-
nyaingi sistem berbasis RDRAM

PC-800 yang sudah lebih dulu
mengadopsi sistem dual channel.

Syarat Ketat
Sebagian pengguna yang

sebenarnya sudah memiliki
sistem dual channel mungkin
perlu mempertanyakan lagi,
apakah sistem yang dijalankan
sudah benar-benar
mengaplikasikan teknologi ini.
Bukan-apa-apa. Teknologi ini
memang menuntut syarat yang
lumayan ketat dan cara
pemasangan yang benar agar
dual channel-nya bisa berfungsi.

Syarat pertama yang harus
dipenuhi tentu saja motherboard
yang digunakan. Untuk dapat
mengaplikasikan sistem dual

channel, Anda me-
mang harus memiliki
motherboard dengan
chipset tertentu, misal-
nya nForce2, i875,
i865, dan lain-lain. Se-
lain itu, memori yang
digunakan pun harus-
lah minimal dua ke-
ping plus syarat-syarat
lainnya. Lalu bagai-
mana memastikan sis-
tem sudah menerap-
kan sistem dual

channel? Untuk memastikannya,
ada beberapa langkah
yang bisa ditempuh.

1. Masukkan
ke Soket
DIMM yang
Sesuai
Ini adalah langkah

awal yang paling
penting agar sistem
Anda bisa
mengoptimalkan sistem
dual channel. Ketika
memasang memori
pada soket DIMM,
Anda harus tahu benar
konfigurasi DIMM yang harus
dipakai supaya teknologi ini bisa
bekerja. Untuk itu, Anda harus

membaca dengan seksama buku
manual motherboard yang
dipakai. Hal ini penting karena
tiap motherboard memiliki
konfigurasi yang berbeda untuk
menjalankan dual channel.
PCplus misalnya, memiliki A7N8X
ber soket DIMM 3 buah. Agar
sistem bekerja pada sistem dual
channel, dua keping memori
harus dipasang pada soket 2 dan
soket 3. Atau bila mungkin
memori yang sana dipasangi
pada ketiga soket tersebut.
Sementara, pada sistem lain

mengharuskan pemasangan pada
soket DIMM 1 dan 3, 2 dan 4,
atau pada keempatnya.

2. Pastikan pada
saat Booting
Ulang
Setelah memori yang ada

dipasang, untuk memastikan
apakah sistem PC telah meng-
gunakan sistem dual channel,
langkah selanjutnya adalah
melakukan booting ulang. Pada
sebagian besar motherboard
yang support teknologi yang
menawarkan bandwidth dua
kali lipat dibanding sistem
terdahulu ini, BIOS-nya juga
dilengkapi dengan fasilitas
pada saat booting yang me-
nampilkan apakah sistem se-
dang menjalankan sistem dual
channel atau single channel.

3. Update BIOS
Jika di sistem Anda belum

disertakan, Anda mungkin
harus meng-update BIOS Anda
agar tampilan seperti ini
muncul saat booting. Ini
misalnya pernah terjadi pada
PCplus ketika menggunakan
satu motherboard ber-chipset
granite bay. Sebelum BIOS-nya
di-update, keterangan ini tidak
muncul saat booting. Namun,
setelah BIOS diperbarui, kete-
rangan ini kemudian muncul.

Mudah bukan? Dengan
melakukan 3 langkah mudah
ini, Anda akan merasakan
nikmatnya menggunakan
teknologi dual channel pada
sistem Anda.
Selamat mencoba. PC+
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Pasang pada soket yang tepat sesuai
petunjuk buku manualnya

Saat booting ulang, pastikan sistem dual
Channel sudah diaplikasi



14 |

plusLinux IV • 27 Agustus - 02 September 2003
PCplus 141

Vincent Bayu T.B.
vincent@e-pcplus.com

Minggu lalu kita telah belajar mengenali
beberapa alat kerja untuk membuat halaman

induk (pertama) homepage. Sekarang kita akan
mencoba melihat rangkaian contoh halaman
lanjutan dan menghubungkannya lewat link.

Kita bisa menghubungkan halaman itu dengan
halaman lain, e-mail maupun website rujukan.

ebelumnya, satu hal yang sangat penting untuk
diperhatikan adalah kita harus menempatkan file penyusun
homepage (tombol, foto, teks, halaman HTML homepage,
dan unsur lainnya) menjadi satu dalam satu folder. Jangan di

pisah-pisahkan, karena akan menyebabkan trouble saat pengujian off-
line maupun saat publish di Internet.

MacromediaDreamWeaver:
Membangun Homepage
Bersama Si Penenun

Mimpi ( Bagian 2 )S

Hyperlink di Tombol
Pemberian link di tombol dilakukan dengan klik ganda tombol tersebut, lalu klik

[Browse link] dan pilih file rujukan (yang akan dituju)  (lihat Gambar 1)

Menambahkan E-mail Link
Di antara uraian kita dalam halaman-halaman homepage, seringkali kita

memberikan rujukan alamat e-mail supaya audiens bisa mengadakan komunikasi atau
memberikan tanggapan, saran via e-mail. Beberapa Web site juga sering kita
cantumkan sebagai rujukan agar audiens bisa mendapatkan informasi lebih lengkap
dan mengadakan follow-up (tindak lanjut).  Tambahkan e-mail link dengan mengeblok
teks alamat e-mail atau URL (alamat Web site), lalu klik menu [Insert]>[E-mail link].
Teks alamat e-mail atau URL tersebut akan berubah warnanya dan nantinya jika di klik
akan mengarahkan audiens ke alamat rujukan tersebut  (lihat Gambar 2).

Kita sudah mulai paham anatomi homepage beserta garis besar cara kerjanya.
Pada bahasan minggu depan akan mencoba mem-publish homepage menjadi online.
Sebagai catatan tambahan, Anda bisa belajar banyak soal desain dan pembangunan
homepage, Web site di URL www.webmonkey.com.

Selamat mencoba. PC+

Hyperlink di Foto atau Gambar
Hyperlink bisa juga kita berikan pada gambar atau foto. Caranya, klik foto

sehingga muncul bingkai tanda aktif.  Klik ikon [Link] di kotak Properties foto, lalu
isikan file rujukan (lihat Gambar 3).

Contoh Rangkaian Halaman Homepage
Berikut ini disajikan contoh rangkaian halaman homepage  (Gambar 4),

(Gambar5), (Gambar6), (Gambar7).

Menguji Homepage Secara Offline
Sebelum benar-benar “ditayangkan” online alias di-publish di Internet, homepage

perlu kita uji terlebih dahulu, terutama kerja hyperlink dan e-mail link-nya.  Jika masih
ngadat, cari tahu penyebabnya dan perbaiki sampai semuanya OK dan siap tayang.
Kita menguji offline menggunakan Internet browser, misalnya Internet Explorer atau
Netscape Navigator. Caranya:
1. Buka Internet Explorer. Klik menu [File]>[Open]>[Browse]. Cari folder tempat kita

menyimpan file penyusun homepage.  Buka halaman pertama homepage. Klik
[OK]. Jika muncul peringatan: Cannot open ….Would you like see its default
view instead?.  Jawab atau klik Yes.

2. Klik hyperlink ke halaman lain.  Demikian pula, pada halaman lanjutan, klik
hyperlink ke halaman pertama.  Uji pula Web site dan e-mail link.  Jika berhasil,
maka homepage siap di-publish di Internet (Gambar 8).

Gambar 1

Gambar 2

Gambar 3

Gambar 4

Gambar 5

Gambar 6

Gambar 7

Gambar 8
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Memori Pengkodean Kapasitas Jumlah Chip Single/Double
1 Keping DRAM        Sided

KHX3200AK2/512 KHX 256MB       8 SS
KVR400X64C25/512 KVR 512MB      16 DS
CMX256A-3200C2 CMX 256MB       8 DS
V-GEN PC-3200 V-32 256MB       8 SS
V-GEN PC-2700 V-27 256MB       8 SS

Konfigurasi
Untuk Dual Channel Memory

Cakrawala Gintings
cakra@e-pcplus.com

Sistem memori dua
kanal saat ini sudah

semakin gencar
digalakkan pada

komputer desktop.
Meskipun sebenarnya

bukan merupakan
fenomena baru,

namun dukungan
terkini sistem dual

channel memory
DDR400 yang juga

sudah digunakan Intel
membuat pasar

menjadi semakin yakin
bahwa ke depannya

teknologi yang
dikembangkan akan

berbasis dual channel.

ada awal
peluncuran prosesor
Pentium-4, sebenarnya
Intel telah

memperkenalkan kepada dunia
bahwa sistem dual channel
memory dapat menggandakan
bandwidth memori utama. Saat
itu, jenis memori yang diusung
oleh mereka adalah RDRAM
buatan Rambus. Namun, sistem
dual channel Rambus ini kurang
diterima oleh sebagian besar
pasar karena harga memorinya
yang cukup tinggi.

Melihat pesatnya
perkembangan teknologi DDR
dan penerimaan pasar, Intel
kemudian beralih untuk
mendukung teknologi ini.
Merekapun mulai membuat
sistem untuk dukungan dual
channel memory yang dimulai
dengan chipset E7205.

Chipset yang memiliki kode
Granite Bay ini memang
usianya tidak panjang. Intel
tampaknya hanya
menggunakan chipset ini
sebagai batu loncatan ke
generasi chipset berikutnya.
Saat itu, mode dual channel
memory yang didukung oleh
Granite Bay hanyalah DDR266
atau PC-2100.

Berikutnya, Intel
memperkenalkan chipset i875P
(Canterwood) sebagai produk top
of the line bagi PC desktop.
Dipersenjatai dengan sejumlah
perlengkapan, chipset ini sudah
mendukung dual channel
DDR400. Untuk memberikan
kesempatan bagi mainstream
atau value user, Intel juga
membuat jajaran chipset i865
(Springdale). Sama seperti
Canterwood, Springdale juga
mendukung dual channel
DDR400.

Di antara Granite Bay
dengan Canterwood-Springdale
tersebut, terdapat chipset SiS655
buatan SiS yang sudah
mendukung dual channel DDR
untuk Pentium-4.

Dual channel milik SiS655
sudah mendukung DDR266,
DDR333, dan DDR400. Namun
untuk DDR400, hanya beberapa
modul memori saja yang dapat
digunakan karena adanya

P

Muhammad Firman
firman@e-pcplus.com

masalah kompatibilitas.
Untuk dapat mengaktifkan

fitur dual channel memory pada
sistem berbasis Intel, Anda dapat
melihat pada pembahasan PCplus
beberapa edisi yang lalu.
Meskipun begitu, pada pengujian
kali ini penggunaan memori yang
memiliki jumlah bank yang
berbeda (single sided digabung
dengan dual sided) tetap bisa
membuat dual channel berfungsi,
tentunya apabila syarat yang lain
dipenuhi.

Untuk sistem berbasis
prosesor AMD sendiri, satu-
satunya vendor chipset yang
telah membuat produk yang

mendukung dual channel
memory adalah nVidia. VIA, yang
pada awalnya merupakan
produsen chipset-chipset terkuat

untuk prosesor AMD, kini
tampaknya sudah tertinggal
cukup jauh oleh nVidia. Produsen
yang satu ini masih juga belum

meluncurkan chipset yang
mendukung penggunaan dual
channel memory.

Sebagai produsen chipset,

nVidia sendiri baru memulainya
dengan nVidia nForce.

Pada awal peluncurannya,
nForce ini kurang mendapat

respon yang besar meskipun
sudah mendukung dual channel
memory DDR266. Pada chipset
ini, untuk mengaktifkan mode

dual channel memory,
penggunanya harus
memasangkan satu keping
memori di slot ketiga, dan satu
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keping memori di slot kedua
atau kesatu. Mengenai
kapasitasnya dan kecepatannya
tidak menjadi masalah.

Meskipun sudah
mendukung dual channel
memory, kinerja sistem chipset
nForce ini hanya sedikit lebih
baik daripada milik VIA,
meskipun sudah mengaktifkan
mode dual channel memory-
nya.

Belum lama ini nVidia
telah meluncurkan nForce
terbarunya yaitu nForce-2
Ultra 400. Perbedaan utama
dari chipset ini dibandingkan
versi sebelumnya adalah pada
dukungan FSB 400MHz. Pada
nForce-2 Ultra 400 ini
penggunaan prosesor pada
FSB 400 secara stabil telah
dimungkinkan. Untuk
penggunaannya masih tetap
sama. Pemilik motherboard
chipset nForce harus
memasangkan satu keping
memori di slot ketiga, dan
satu keping memori di slot
kedua atau kesatu, atau di
semua slot-nya bila
menggunakan lebih dari dua
keping. Mengenai kapasitas
dan kecepatannya juga tidak
masalah.

Pengujian
Untuk membandingkan

kinerja dual channel memory
pada sistem berbasis Intel dan
AMD, PCplus melakukan
pengujian dengan testbed
sebagai berikut:

* Untuk Intel
• Motherboard Albatron

PX865PE Pro II yang
menggunakan chipset
i865PE dengan BIOS versi
1.01.

• Prosesor Intel Pentium-4
3GHz dengan FSB 800MHz.

• Windows XP Professional
dengan Service Pack 1 dan
Detonator XP 43.45.

* Untuk AMD
• Motherboard Albatron

KX18D Pro II yang
menggunakan chipset
nVidia nForce-2 Ultra 400
dengan BIOS versi 1.03.

• Motherboard ASUS A7N8X
yang menggunakan chipset
nVidia nForce-2 yang belum
Ultra 400 dengan BIOS versi
1004.

• Prosesor AMD Athlon XP
3000+ dengan FSB 333MHz.

• Windows XP Professional
dengan Detonator XP 44.03.

Perlengkapan uji lain
yang kami gunakan adalah
kartu grafis MSI GeForce-4
Ti4800 128MB, harddisk
Seagate Barracuda 7200.7, dan
power supply Enlight 420W.
Untuk memorinya, kami
menggunakan memori
Kingston KHX3200AK2/512,
Kingston KVR400X64C25/512,
Corsair CMX256A-3200C2, V-
Gen PC3200, dan V-Gen
PC2700.

Pengujian kami lakukan
dengan menggunakan
beberapa kombinasi memori-
memori tersebut pada kedua

sistem. Sedangkan aplikasi uji
yang kami gunakan adalah
Sisoft Sandra 2003 pada
Memory Bandwidth Benchmark
dan Quake 3 Arena dengan
mode Normal serta High
Quality 1024 x 768.

Pada pengujian ini, semua
memori berjalan di mode
DDR400, kecuali kami sebutkan

bahwa memori yang
bersangkutan bekerja pada
kecepatan di bawahnya dan
tentunya memori V-Gen PC2700
kami jalankan pada DDR333
(DDR320 pada Intel).

Kalau terjadi kombinasi
antara satu atau lebih memori
DDR400 dengan DDR333, maka
dari BIOS memori kami set untuk

bekerja pada DDR333 atau
DDR320.

Untuk setting memori di
BIOS, semua CAS Latency-nya
kami buat pada 2,5, Active to
Precharge Delay 8, DRAM RAS#
to CAS# Delay 3, dan DRAM RAS#
Precharge 3.

Pada pengujian tersebut,
bila Anda perhatikan,

konfigurasi pengujian pada
Intel dan nVidia sedikit
berbeda. Tujuan dari pengujian
ini memang untuk melihat
pengaruh konfigurasi memori
yang digunakan terhadap
kinerja. Untuk hasil lengkap pe-
ngujiannya, Anda dapat
melihat pada grafik yang
tersedia. PC+
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Capture
Tampilan Layar
Secara Praktis

Capture Hunter

Menciptakan
Siklus Wallpaper

Wallpaper Cycler

Walaupun banyak software untuk meng-capture layar monitor
yang dapat kita jumpai, Anda dapat mencoba Screen Hunter. Software
ini kaya akan fitur yang berhubungan dengan capture layar. Menurut
pembuatnya, software ini adalah tool terbaik untuk meng-capture layar.
Anda hanya perlu menekan kombinasi tombol yang dapat Anda
tentukan untuk mengaktifkan Screen Hunter.

Anda dapat meng-capture dengan berbagai model seperti bujur
sangkar, persegi panjang, elips, obyek, window, active window, full
screen, DirectX full screen/screen saver dan movie. Yang menarik dari
Screen Hunter adalah fitur yang dapat merekam keseluruhan objek
dengan Autoscroll serta merekam kursor bila diinginkan. Contoh
penggunaan Autoscroll ini adalah ketika Anda ingin meng-capture isi
halaman situs yang panjang.

Anda juga dapat meng-capture layar secara otomatis pada waktu
yang dapat Anda tentukan dan hasilnya akan disimpan secara otomatis
dengan nama tertentu, yang juga dapat Anda atur. Hasil capture dapat
di-copy ke viewer editor, clipboard, file dan e-mail. Anda dapat
menentukan apakah ingin menyimpan image tersebut dengan format
BMP, JPG, GIF, atau PNG.

Software menarik ini berlisensi shareware. Nah, jika Anda ingin
mencoba software berlisensi shareware ini, Anda dapat mencarinya di
www.wisdom-soft.com.

Rizki Kurniawan
some132@myself.com

Biar nggak bosen, wallpaper pada Windows sering digonta-ganti. Koleksi wallpaper
yang sangat banyak sayang kalau cuma disimpan. Bisa-bisa cuma menghabiskan ruang dalam
harddisk. Lebih baik jika download Wallpaper Cycler yang bisa mengganti wallpaper secara
otomatis dengan siklus tertentu.

Wallpaper Cycler yang berukuran 623KB dapat di-download dari http://
www.esat.kuleuven.ac.be/~mgregoir/Wallpaper-Cycler.htm. Jangan khawatir dipungut biaya
untuk menggunakan Wallpaper Cycler, karena aplikasi ini adalah freeware.

Mudah saja untuk memasukkan koleksi wallpaper agar dapat diantrikan di Wallpaper Cycler.
Ada dua cara untuk melakukannya. Yang pertama adalah menambahkan file wallpaper satu per satu
dengan [Add Image] . Hal ini dilakukan bila berbagai file wallpaper yang ada di dalam PC tersebar di
beberapa folder. Namun jika file wallpaper tersimpan di satu folder, untuk mengantrikannya dapat
menggunakan cara kedua, yaitu dengan menggunakan [Add Folder Recursively]. Kalau ada
wallpaper yang tidak mengena di hati, wallpaper itu bisa disingkirkan dari Wallpaper Cycler. File
wallpaper aslinya tidak dihapus. Wallpaper itu hanya dikeluarkan dari antrean.

Berbagai macam atribut desktop seperti tilling setting dan warna background bisa pula diatur
dengan menggunakan Wallpaper Cycler. Tilling setting adalah bagaimana wallpaper ditampilkan
di desktop. Apakah tile, center, atau stretch. Warna background bisa dipilih dari warna yang ada di
dalam wallpaper di samping warna-warna standar dari Windows.

Wallpaper, berdasarkan setting, selalu berubah dalam waktu tertentu. Waktu pergantiannya
menggunakan satuan detik. Siklus wallpaper dapat di-reset dari aplikasi atau secara otomatis pada saat
Wallpaper Cycler dijalankan. Tidak hanya siklus yang berurutan, siklusnya juga dapat di-shuffle.
Semuanya tergantung dari setting dari pengguna.

Daftar wallpaper bisa disimpan. Hal ini memungkinkan penggunanya untuk membuat tema
tertentu dari wallpaper. Misalkan tema kecantikan, maka berbagai wallpaper yang ada di dalamnya
adalah gambar-gambar wanita cantik. Nah, puas-puasin deh memandang wallpaper “segar”
sepanjang hari.

Alex Pangestu
alex@e-pcplus.com

Animasi teks dapat digunakan untuk memperindah suatu halaman situs. Ada cara mudah dan cepat
untuk menghasilkan animasi teks, yaitu dengan menggunakan CoffeeCup Free Flash Text Wizard.
Namanya panjang ya? Disingkat aja jadi CFFTW. CFFTW dapat di-download dari www.tucows.com/
preview/326431.html dengan ukuran file instalasi 2,3MB.

Cara penggunaan CFFTW sangat sederhana. Kita tinggal memilih ukuran panjang dan lebar movie
yang akan dihasilkan, kemudian memilih warna latar belakang yang digunakan, memasukkan teks yang
dianimasikan serta efek teks yang dihasilkan. Font untuk teks dapat diubah-ubah sesuai selera. Begitu juga
warna dan ukurannya.

Animasi yang ada pada CFFTW adalah explode, assembler, roller, typewriter, randomizer, wave, wave
two dan wave three. CFFTW tidak menyediakan preview animasi yang dihasilkan. Ini yang menyulitkan
kita untuk memilih animasi yang cocok. Kita harus menyimpan dulu animasi yang dibuat, baru kemudian
secara otomatis CFFTW akan membuka Internet Explorer untuk menampilkan hasilnya.

Output dari CFFTW adalah SWF alias animasi Flash. Kalau SWF-nya sudah jadi, tinggal ditempel di
halaman situs dengan menggunakan aplikasi pembangun situs seperti Dreamweaver atau Frontpage.

Alex Pangestu
Alex@e-pcplus.com

Animasi Teks Instan
CoffeeCup Free Flash Text Wizard
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WinDriversBackup Personal Edition

Backup Semua
Driver Window

Pembuat
Flowchart Andal

Source Code2Flowchart

Untuk membuat suatu program, sebaiknya kita merencanakan
terlebih dahulu secara matang apa dan bagaimana prosesnya. Nanti
baru ditulis pemrogramannya. Agar pemrograman lebih terstruktur,
kita perlu membuat persiapan-persiapan tertentu seperti membuat
diagram alir (flowchart). Anda bisa mengambil kertas buram dan
mulai mencorat-coret flowchart, setelah menggambarnya, kemudian
Anda mulai menulis pemrogramannya. Namun sayangnya para
programmer kadang melupakan hal penting ini. Dengan demikian,
orang lain akan sulit mengerti bagaimana logika program tersebut.

Kita dapat menggunakan software seperti SourceCode2Flow-
Chart untuk menganalisa source code yang dipilih kemudian ditampil-
kan dalam bentuk flowchart. Source code
yang dapat dianalis juga beragam,
diantaranya C/C++, VBA, Java, Qbasic/basic,
Perl, Delphi/Pascal, Visual FoxPro,
JavaScript, PHP, VBScript, Visual C#, VB.NET
dan masih banyak lagi.  Setelah Anda
menentukan file mana yang akan
dianalisis, kemudian ke awal source code
yang ingin dianalisis, klik kanan
kemudian pilih [Mark Begin Line of
Code]. Lakukan cara yang sama pada
akhir source code, lalu pilih [Mark End
Line of Code]. Anda akan melihat
flowchart yang diinginkan dengan level
yang juga dapat Anda tentukan. Level ini
tidak terbatas jumlahnya, tergantung
kerumitan source code program yang
dianalis.

SourceCode2Flowchart ini juga
dapat Anda gunakan untuk menulis atau
mengedit source code tetapi tidak untuk
mengompilasinya. Selain itu, dengan
aplikasi ini Anda dapat menyimpan
flowchart tersebut ke format bitmap atau
menyambungkannya ke Visio. Tersedia
juga fitur dimana Anda dapat

menyimpan source code ke format RTF atau HTML. Anda juga dapat
mengganti gambar flowchart melalui folder tempat
SourceCode2Flowchart diinstal, sehingga flowchart yang dibentuk
sesuai versi Anda.

Software ini sebaiknya Anda coba karena memang akan sangat
membantu dalam pemrograman. Software berlisensi shareware ini
juga kompatibel dengan Windows XP. Nah, jika Anda ingin
mencobanya, silakan mencari di situsnya www.fatesoft.com/s2f
dengan ukuran 1,16MB. Selamat mencoba.

Rizki Kurniawan
some132@myself.com

WinDriversBackup Personal Edition adalah sebuah
tool yang dapat mem-backup semua driver yang ada di Windows,
baik itu driver kartu grafis, printer, TV tuner, USB dan sebagainya.
Tool ini akan mengidentifikasi semua driver yang terdapat di Win-
dows lalu mem-backup-nya.

Anda dapat mengidentifikasi semua driver, atau hanya driver
buatan Microsoft. Driver non Microsoft lah yang sebenarnya perlu
untuk di-backup, karena driver buatan Microsoft sudah ada saat
Anda menginstal Windows, jadi tidak perlu di-backup lagi.

Dengan mem-backup driver yang ada pada Windows akan
mempermudah Anda pada saat Anda perlu menginstal ulang
Windows. Karena sudah di-backup driver tersebut tidak perlu diinstal
ulang. WinDriversBackup akan menyimpan file driver di lokasi yang
dapat Anda tentukan sendiri.

WinDriversBackup sangat berguna apabila Anda tidak
mengetahui hardware yang terdapat di dalam PC Anda atau apabila
source driver Anda hilang (misalnya CD penyerta hardware Anda
hilang). Tool ini akan mengidentifikasi driver dari hardware tersebut
dan Anda tinggal menyimpan file driver-nya.

Tool ini dapat Anda download di www.jermar.com dengan file
sebesar 2,44 MB. Best of all, it’s free!

Jimmy Sundjaja
bintang@rad.net.id
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Memilih
Motherboard

Bukan
Perkara

Gampang!

Silvester Sila Wedjo
sila@e-pcplus.com

Memilih bisa menjadi
pekerjaan paling

menjengkelkan dan
membingungkan.

Menjengkelkan karena
sejenak kita

terombang-ambing
pada suatu keadaan

tak pasti.
Membingungkan
karena sering kali

pilihan itu sangat tipis
perbedaannya

sementara dari sekian
banyak pilihan yang

tersedia, kita harus
segera menentukan

mana yang paling pas
dan sesuai buat kita.

egitu pula
halnya dengan urusan
memilih komponen
PC. Dari sekian jenis

dan merek, kita harus memutus-
kan satu saja yang akan dipakai.
Terkadang, pilihan tak selalu
jatuh pada barang atau kompo-
nen yang paling mahal atau yang
paling murah. Ada beberapa
pertimbangan yang harus
diperhatikan sebelum memutus-
kan memilih satu di antara sekian
banyak varian yang ada.

Memilih motherboard
apalagi. Komponen maha
penting selain prosesor dalam PC
ini ibarat jantung dari sistem PC,
lantaran semua komponen pada
PC berhubungan dengan
perangkat yang satu ini. Apalagi
pada PC modern. Banyak sekali
fitur penting yang diintegrasikan
pada komponen yang satu ini.
Alhasil, selain prosesor yang
harus benar-benar terpilih,
motherboard-nya  pun tidak
boleh sembarangan kalau Anda
tidak ingin menyesal di kemudian
hari.

Namun, ketika memilih
motherboard, pilihan yang
tersedia amatlah beragam.

Sekian puluh merek yang beredar
di pasaran mengusung puluhan
pula tipe khusus yang sangat
menarik. Bisa dikatakan, untuk
jenis komponen PC, motherboard
merupakan salah satu komponen
yang paling banyak variasi dan
tipenya dibandingkan produk
lain seperti prosesor, harddisk,

monitor, atau memori. Apalagi,
rata-rata produk-produk
motherboard tersebut memiliki
keunggulan sendiri-sendiri, baik
dari kualitas, ketahanan, kestabi-
lan, fitur yang diusung, maupun
harga yang cukup menggiurkan.

Uniknya lagi, hampir tiap
bulan juga  selalu muncul jenis-
jenis baru yang mengusung fitur

baru dan menawarkan performa
yang lebih baik. Ini tentu saja
menambah kebingungan calon

pembeli yang bermimpi memiliki
PC yang paling gres, cepat, dan
paten, namun dengan harga
terjangkau.

Nah, biar nggak bingung
dan lebih selektif dalam memilih,
ada baiknya Anda
memperhatikan hal-hal penting
yang bisa jadi pertimbangan

Anda sebelum memutuskan
memilih “jantungnya” sistem PC
Anda.

Tentukan Jenis
Prosesornya

Yang pertama harus Anda
pertimbangkan adalah prosesor
yang akan dipakai. Ada 2
prosesor yang beredar saat ini

yaitu yang berbasis Intel, AMD.
Ada satu jenis prosesor lagi
keluaran VIA, tapi tampaknya di
pasaran barang ini sangat sulit
didapatkan dan tidak terlalu
menarik calon pembeli.

Buat yang memilih Intel
sebagai basis prosesornya, selain
jenisnya yaitu Pentium-4 mau-
pun Pentium-4 Celeron, Anda
juga harus mempertimbangkan
hal-hal lain di dalamnya semisal,
front side bus yang dipakai, cache
L2 yang diusung, dan kecepatan-
nya. Terbaru, Anda juga
sebaiknya mempertimbangkan
apakah memerlukan prosesor
yang mampu menjalankan hyper-
threading atau tidak.

Bila memilih Celeron, tentu
harga yang ditawarkan lebih
murah, meski dari segi
kemampuan, Anda harus puas
dengan performa yang standar
dibanding menggunakan
Pentium-4. Front side bus yang
digunakan prosesor yang Anda
beli pun harus diperhatikan
karena Pentium-4 punya 3 versi
FSB yang berbeda yaitu 400MHz,
533MHz, dan 800MHz. Hal ini
penting diperhatikan mengingat
motherboard yang ada di
pasaran tidak semua mampu
bekerja pada FSB 800MHz.
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C
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us

Bandingkan Spesifiksi tiap produk yang ditawarkan biar Anda tidak
salah beli

Fitur yang ditawarkan harusnya jadi pertimbangan utama dalam
memilih motherboard yang akan dipakai
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 Tentu mubazir jika prosesor
Anda sudah mampu bekerja di
FSB 800MHz namun motherboard
Anda tidak mendukung kemam-
puan ini. Begitu pula sebaliknya.
Ibaratnya, Anda memiliki jalan
tol yang lebar tetapi untuk
melintasnya Anda menggunakan
sepeda motor butut.

 Hal yang hampir sama juga
berlaku bila Anda memutuskan
menggunakan sistem berbasis
prosesor AMD. Ada 2 pilihan
yang bisa dipertimbangkan yaitu
Duron yang harganya jauh lebih
murah dan Athlon XP yang
menawarkan kemampuan yang
lebih baik. Sama seperti apabila
Anda memilih sistem berbasis
Intel, di sini front side bus yang
dipakai prosesornya juga
memainkan peran penting waktu
memilih motherboard. Fitur ini
perlu diperhatikan karena tidak
semua motherboard berbasis
AMD mendukung FSB terbaru
yang sebesar 200MHz.

Dalam memilih
motherboard, Anda harus
memperhatikan betul, batas
kecepatan FSB yang mampu
didukung motherboard. Ini
penting agar kecepatan prosesor
Anda yang tinggi tidak mubazir

hanya lantaran motherboard-nya
tidak mendukung FSB setinggi
prosesornya.

Tentukan Chipsetnya
Penentuan chipset yang

dipakai adalah salah satu
pertimbangan tersulit waktu
memilih motherboard. Harap
maklum, ada puluhan jenis

chipset yang dipakai oleh sekian
banyak tipe motherboard yang
beredar saat ini. Yang bagus
performanya umumnya memang
motherboard yang mengusung
chipset terbaru. Namun begitu,
harga yang harus Anda bayar
tentu jauh lebih besar ketimbang
memilih motherboard yang

mengusung chipset yang agak
lawas.

Buat yang mendambakan
performa tinggi, motherboard-
motherboard terkini ber-chipset
mentereng macam i875P, SiS655
buat Intel atau nForce2 dan
nForce2 Ultra untuk yang
berbasis AMD memang sangat
menggiurkan. Chipset-chipset ini
memang yang paling mutakhir
saat ini yang menyediakan begitu
banyak fitur terbaru dengan
kemampuan wahid.

Selain mampu mengusung
prosesor tertinggi dengan
kecepatan FSB tertinggi,
beberapa fitur terbaru yang
cukup penting sudah terintegrasi
dalam ini. Contohnya adalah
penggunaan sistem dual channel
pada chipset-chipset di atas
sehingga mendukung bandwidth
memori yang besar. Seperti dike-
tahui, adanya sistem dual channel

ini memungkinkan performa
sistem meningkat dibanding
menggunakan sistem single
channel yang konvensional.

Konsep yang dahulunya
hanya ada pada sistem berbasis
memori Rambus ini memang
tengah naik daun lantaran
peningkatan performa yang
ditawarkan. Namun, untuk itu

sejumlah persayaratan juga harus
dipenuhi agar sistem dual
channel yang berbasis memori
double data rate ini bisa
berfungsi. Penggunaan dua
memori atau lebih dengan chip
memori dan kapasitas yang sama
jadi syarat mutlak agar sistem
dual channel bisa berfungsi.

Namun bila harganya masih
terasa agak tinggi, motherboard
lain yang berbasis i865PE,
SiS648FX untuk yang berbasis
Intel atau VIA KT400 buat AMD
bisa dipilih dengan harga lebih
murah. Namun, untuk chipset-
chipset ini Anda tidak akan men-
dapatkan fasilitas dual channel
memori seperti pada chipset di
atas. Anda bisa membandingkan
performa memori dual kanal
pada artikel plusFokus edisi ini

di halaman 15-17.
Bila kocek Anda lebih

terbatas lagi, motherboard ber-
chipset lebih lawas semisal i845PE
atau KT333 adalah pilihan yang
sudah cukup bijaksana karena
biasanya harga yang ditawarkan
lebih murah ketimbang yang
lebih baru, meski beberapa fitur
baru tidak bisa didapat.

Onboard VS Add on
Anda pun punya pilihan lain

bila harga yang ditawarkan jenis-
jenis di atas masih terlalu tinggi.
Anda bisa membeli tipe lain yang
menawarkan kartu grafis
onboard semisal i845G, i865G dan
varian-variannya agar harga
keseluruhan sistem bisa ditekan
lebih rendah lagi karena tidak
perlu lagi membeli kartu grafis.
Dengan kartu grafis onboard ini
aplikasi-aplikasi 3D standar
memang masih bisa ditangani
dengan baik. Namun, bila Anda

ingin performa lebih untuk
aplikasi grafis, Anda memang
harus memilih sistem dengan
kartu grafis terpisah alias add on.

Namun, jika dananya
memang sedang terbatas, banyak
tipe motherboard yang
menawarkan fasilitas VGA
onboard namun tetap
mengusung port AGP. Tipe
motherboard ini bisa jadi
alternatif jika Anda tidak puas
dengan kinerja kartu grafis
onboard. Anda bisa
menggantinya dengan kartu
grafis add on tanpa perlu
mengganti motherboard-nya.

Selain itu, jenis sound card
alias kartu suara yang terintegrasi
dalam motherboard juga harus
diperhatikan. Sekarang  ada
banyak pilihan controller kartu

suara yang terpasang pada
motherboard. Meski umumnya
semua motherboard terkini
sudah mendukung suara 6 kanal,
Anda juga bisa memilih jenis
sound card onboard yang sudah
mendukung penggunaan S/PDIF
agar kualitas suara yang
dihasilkan bisa maksimal. Namun,
kalau Anda ingin yang add on,
pastikan slot PCI pada mother-
board masih mencukupi untuk
“ditancapi” sound card maupun
kartu-kartu tambahan lainnya.

Fasilitas Tambahan
Selain fasilitas standar,

hampir sebagian besar
motherboard modern
mengusung pula fitur tambahan
yang menarik. Yang paling umum
misalnya LAN onboard dengan
menggunakan chip tertentu.
Fasilitas ini buat kalangan
kantoran memang menarik,
meski untuk rumahan biasa tentu

tak berguna apa-apa.
Belakangan, muncul pula RAID
controller dengan port-nya bila
pengguna ingin keamanan data
lebih baik maupun back up data
harddisk. Pada beberapa tipe
terbaru disediakan pula fasilitas
serial ATA sehingga motherboard
tersebut kompatibel untuk sistem
interface harddisk yang terkini.
Fasilitas lain yang tak ketinggalan
hampir selalu ada adalah
interface kecepatan tinggi
macam USB 2.0 maupun IEEE1394
firewire.

Uniknya, buat sebagian
pengguna yang tidak
memerlukan komponen-
komponen tambahan terebut,
beberapa merek mengusung tipe
standar yang harganya cukup
miring dibanding jenis yang

memiliki banyak fitur, meski dari
jenis motherboard yang sama.
Jelas ini menguntungkan buat
sebagian orang yang memang
tidak ingin menggunakan
fasilitas tambahan namun
memilih jenis motherboard yang
sama karena harganya yang lebih
terjangkau.

Selain banyaknya fasilitas
yang disediakan, merek yang
diusung juga mempengaruhi
harga jual. Urusan harga ini
selain dipengaruhi performa
kerja, kestabilan, pemilihan kom-
ponen, dan fitur yang diusung,
juga dipengaruhi oleh merek
yang diusung. Selain karena
pengalaman dan performa yang
lebih, jaminan nama besar terka-
dang membuat harga mother-
board yang diusung relatif lebih
tinggi dibanding yang lain, meski
dari segi kualitas pada tipe-tipe
tertentu performanya tidaklah
berbeda jauh. PC+

Banyaknya pilihan yang ditawarkan membuat Anda harus pandai-pandai
memilih

Jangan sungkan untuk menanyakan fitur-fitur yang ada pada pedagang
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Menggambar
Pie Chart

Yahya Kurniawan
yahya@e-pcplus.com

Pie chart adalah
gambar lingkaran yang

dibagi-bagi menjadi
beberapa bagian yang

masing-masing
menunjukkan

persentase dari sebuah
pengolahan data.

Bentuk ini menyerupai
kue bundar yang

dipotong-potong,
itulah sebabnya

mengapa disebut "pie"
chart. Pie chart

merupakan bentuk
pemaparan olahan

data yang cukup
disukai selain bentuk

balok. Memang
penyajian dalam

bentuk visual memiliki
nilai lebih daripada

kita memelototi
angka-angka saja.

Bikin pusing.

omposisi luas
masing-masing bagian
potongan pie chart
sesuai dengan

persentase data yang diwakilinya.
Bukan cuma luasnya saja yang
sesuai, tetapi lebar sudut
ataupun panjang keliling masing-
masing potongan juga sesuai
dengan perbandingan persentase
data yang diwakilinya. Nah, yang
akan digunakan sebagai
pegangan dalam menggambar
pie chart dengan PHP adalah
komposisi lebar sudut masing-
masing bagian pie. Langkah
membuat pie chart dengan PHP
adalah sebagai berikut:

Mula-mula diambil
persentase dari masing-masing
data yang akan disajikan,
kemudian persentase tersebut
dibulatkan dan dikonversikan
menjadi derajat (100% adalah
360 derajat). Kemudian digambar
sejumlah lingkaran dengan titik
pusat sama, tetapi kelilingnya
saling bersambung satu sama lain
dan panjangnya sesuai dengan
persentase yang telah ditentukan
sebelumnya. Langkah berikutnya
adalah menggambar garis dari
titik pusat lingkaran menuju ke
batas keliling setiap bagian.
Koordinat pangkal garis sama
dengan koordinat titik pusat
lingkaran, sedangkan koordinat
ujung garis ditentukan dengan
menggunakan perhitungan
matematis sebagai berikut (lihat
Gambar 1 sebagai panduan):

Pada gambar tersebut, ada
sebuah lingkaran dengan jari-jari
r dan pusat di (a,b) yang nilai a
dan b telah diketahui. Ada
sebuah potongan di dalamnya
yang membentuk sudut a. Untuk
mencari koordinat (x,y) maka
diperlukan bantuan rumus
trigonometri sin dan cos. Panjang
garis putus-putus adalah r sin a,
sedangkan panjang garis
mendatar dari titik pusat sampai
ke perpotongan dengan garis
putus-putus adalah r cos a. Jadi
nilai x adalah a + (r cos a) dan
nilai y adalah b + (r sin a). Anda
tidak perlu dipusingkan dengan
arah koordinatnya (misalnya ke

kiri adalah negatif dan ke kanan
adalah positif) karena nilai sin a
dan cos a akan menyesuaikan
dengan sendirinya sesuai dengan
besar sudut a. Pada PHP, rumus
tersebut perlu sedikit
disesuaikan, karena koordinat
harus selalu berupa integer.
Dengan demikian, nilai r sin a
dan r cos a harus selalu
dibulatkan. Selain itu nilai derajat
juga dikonversikan ke radian.

Yang terakhir adalah
memberi warna pada tiap bagian
pie chart yang telah terbentuk.
Untuk memberi warna, mula-
mula harus dicari koordinat
sebuah titik yang terletak di
dalam setiap bagian pie chart
sebagai titik awal pewarnaan.
Mudahnya, titik tersebut dicari
dengan membagi dua sudut
sebuah bagian pie, kemudian
diambil panjang setengah jari-jari
pie, sehingga titik tersebut akan
terletak di tengah suatu bagian
pie. Lihat Gambar 2. Titik t
adalah titik tengah suatu bagian
pie.

Nah, teori pembuatan pie
chart di atas jika dibahasakan
dengan skrip PHP adalah sebagai
berikut:

<?
Header("Content-Type:image/
jpeg");

// --- menentukan data yang
akan dibuat pie chartnya --- //
$data[0] = 24;
$data[1] = 41;

$data[2] = 32;
$data[3] = 49;
$data[4] = 37;
// --- deklarasi variabel --- //
$total = 0;
$d = array();
$kor_x = array();
$kor_y = array();
$t_x = array();
$t_y = array();
// --- menentukan besar sudut
setiap bagian pie --- //
for($j=0;$j<=4;$j++) {

$total += $data[$j];
}

$d[0] = 0;
for($i=1;$i<=5;$i++) {

$d[$i] =
($data[$i-1]/$total) *
360;

$d[$i] +=
$d[$i-1];
}
// --- menentukan

warna --- //
$img = ImageCreate

(300,300);
$warna[0] =

ImageColorAllocate
($img,0,255,0);
$warna[1] =
ImageColorAllocate
($img,255,0,0);
$warna[2] =
ImageColorAllocate
($img,0,0,255);
$warna[3] =
ImageColorAllocate
($img,255,0,255);
$warna[4] =
ImageColorAllocate(
$img,255,255,0);
$hitam = ImageColorAllocate
($img,0,0,0);
$putih = ImageColorAllocate
($img,255,255,255);
ImageFill($img,0,0,$putih);
// --- membentuk pie --- //
for($k=1;$k<=5;$k++) {
// --- menggambar bagian-
bagian pie --- //
ImageArc
($img,150,150,250,250,$d
[$k1],
$d[$k],$hitam);

// --- mencari
koordinat batas --- //

$kor_x[$k] =
round(150+(125*cos

(deg2rad($d[$k-1]))));
$kor_y[$k] =
round(150+(125*sin
(deg2rad($d[$k-
1]))));

// --- mencari
titik tengah --- //

$t = round
(($d[$k-1]+$d[$k])/2);

$t_x[$k] =
round(150+(62.5*cos

(deg2rad($t))));
$t_y[$k] =

round(150+(62.5*sin
(deg2rad($t))));

ImageLine($img,150,150
,$kor_x[$k],$kor_y[$k],$hitam);
}

// --- mewarnai bagian pie --- //
for($k=1;$k<=5;$k++) {

ImageFillToBorder
($img,$t_x[$k],$t_y[$k],
$hitam,$warna[$k-1]);
}
ImageJPEG($img);
?>

Hasilnya dapat dilihat pada
Gambar 3.

Dari skrip di atas, ada bebe-
rapa bagian yang memerlukan
penjelasan khusus. Yang pertama
adalah menentukan besar sudut
setiap bagian pie.

// --- menentukan besar sudut
setiap bagian pie --- //
for($j=0;$j<=4;$j++) {

$total += $data[$j];
}
$d[0] = 0;
for($i=1;$i<=5;$i++) {

$d[$i] = ($data[$i-1]/
$total) * 360;

$d[$i] += $d[$i-1];
}

Langkah pertama adalah
menghitung jumlah total nilai
data, kemudian berdasarkan
jumlah total tadi, dihitung besar
setiap bagian pie, yang
diwujudkan dalam besarnya
sudut setiap bagian pie. Besarnya
sudut akan membentuk deretan
bilangan dari 0 sampai 360,
misalnya 0, d1, d2, d3, d4, 360,
dengan d1 < d2 <d3 < d4.

Bagian lain yang harus
diperhatikan adalah bagian
membentuk pie.

// --- membentuk pie --- //
for($k=1;$k<=5;$k++) {
// --- menggambar bagian-
bagian pie --- //
ImageArc
($img,150,150,250,250,$d[$k-

1],
$d[$k],$hitam);

// --- mencari
koordinat batas --- //

$kor_x[$k] =
round(150+(125*cos
(deg2rad($d[$k-1]))));

$kor_y[$k] =
round(150+(125*sin(deg2rad
($d[$k-1]))));

// --- mencari titik
tengah --- //

$t = round(($d[$k-
1]+$d[$k])/2);

$t_x[$k] =
round(150+(62.5*cos
(deg2rad($t))));

$t_y[$k] =
round(150+(62.5*sin

(deg2rad($t))));
ImageLine($img,150,1

50,$kor_x[$k],$kor_y[$k],$hitam);
}
// --- mewarnai bagian pie --- //
for($k=1;$k<=5;$k++) {

ImageFillToBorder
($img,$t_x[$k],$t_y[$k],$hitam,
$warna[$k-1]);
}

Pada saat mencari koordinat
batas, akan diterapkan rumus
yang telah dijabarkan
sebelumnya, yaitu x = a + r cos a
dan y = b + r sin a, dengan
beberapa penyesuaian, seperti
misalnya hasilnya harus
dibulatkan, oleh karena itu
digunakan fungsi round(), lalu
sudut harus dikonversikan dari
derajat ke radian, sehingga
digunakan fungsi deg2rad().
Pada contoh tersebut, ditetapkan
diameter pie adalah sebesar 250,
sehingga jari-jarinnya adalah 125.
Pada saat mencari titik tengah,
terdapat angka 62.5, yang
merupakan setengah dari jari-
jari. Looping untuk mewarnai
perlu dipisahkan dari looping
untuk menggambar pie, dengan
pertimbangan gambar harus jadi
terlebih dahulu, baru kemudian
diberi warna.

Jadilah gambar pie chart
kita. Minggu depan kita
kombinasikan gambar pie chart
ini untuk melengkapi aplikasi
jajak pendapat yang telah kita
buat beberapa minggu lalu. PC+

Gambar 1

Gambar 2

Gambar 3
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3D Blaster 5 RX9600 Pro:

Kartu Grafis Progresif
dari Creative

PT Astrindo Senayasa
www.creative.com
☎ (021) 6121330

XFX KT400-ALH:

Chipset Lawas
untuk Prosesor AMD

Rindang Bumi Utama
www.xfxforce.com
☎ (021) 71791223

76 dolar AS

SysMark 2002
Rating :248
Internet Content :317
Office Productivity:194

SisoftSandra 2003
ALU :8118 MIPS
FPU :3231 MFLOPS

3D Mark 2001
640 x 480  16bit :13797
640 x 480  32bit :13485
800 x 600  16bit :12551
800 x 600  32bit :12132
1024 x 768  16bit :10869
1024 x 768  32bit :10602

Quake III Arena
640 x 480  16bit :254,9fps
640 x 480  32bit :254,6fps
800 x 600  16bit :251,1fps
800 x 600  32bit :250,4fps
1024 x 768  16bit :238,7fps
1024 x 768  32bit :230,0fps

Era chipset VIA KT400
sudah gone with the wind. Hal
ini tampak dengan sudah
banyaknya produk
motherboard yang
menggunakan chipset KT400A
yang menggantikan posisi
KT400. Belum lagi kemunculan
produk-produk motherboard
dengan chipset KT600 yang
tentunya menawarkan
peningkatan teknologi bila
dibandingkan dengan chipset

pendahulunya.
Namun hal tersebut tidak

membuat XFX -salah satu vendor
yang mengkhususkan diri di
bidang kartu grafis dan
motherboard- menghentikan
penjualan motherboard dengan
chipset milik VIA ini. Produk
motherboard dari salah satu divisi
Pine Group yang memiliki kode
produksi XFX KT400-ALH masih
dapat kita jumpai di pasaran.

Produk yang didesain untuk

dapat mendukung prosesor AMD
Duron, Athlon, ataupun Athlon
XP yang ber-FSB mulai dari
200MHz, 266MHz, dan 333MHz
ini dapat digunakan bersama
dengan memori DDR 200, 266,
dan 333. Namun demikian, tidak
tertutup kemungkinan akan
prosesor ataupun memori yang
memiliki FSB lebih tinggi dapat
dipasangkan pada motherboard
ini. Untuk memorinya sendiri,
pada board disediakan sebanyak
tiga buah slot DDR DIMM 184-pin
yang dapat menampung hingga
total maksimum 3GB system
memory.

Secara default, motherboard
ini di-set untuk digunakan
bersama dengan prosesor AMD
yang ber-FSB 266MHz. Agar
dapat dipasangi prosesor AMD
yang menggunakan FSB 333MHz,
pengguna motherboard ini perlu
memindahkan jumper 5 dan
jumper 6 ke posisi yang telah
ditentukan. Penjelasan tentang
langkah ini sudah disertakan
pada lembaran tambahan
manual motherboard.

Chipset VIA KT400 yang

dipasang pada motherboard ini
terdiri dari northbridge VIA
KT400 dengan southbridge VIA
8235. Fasilitas ekspansi yang
tersedia pada motherboard
dengan form factor ATX
berukuran 30,5 x 23,0 cm ini di
antaranya adalah sebuah slot
AGP mode 8x dan sebanyak enam
buah slot PCI. Lebih banyak bila
dibandingkan dengan produk-
produk motherboard lain yang
biasanya hanya menyediakan
lima buah slot PCI.

Pada motherboard ini
tersedia fasilitas 10/100Mbps LAN
onboard yang juga disediakan
oleh chip buatan VIA yaitu VIA
VT6103. Sedangkan untuk
menyediakan solusi integrated
audio, XFX memilih chip Realtek
ALC650 yang merupakan AC’97
Codec yang sudah mendukung 6
channel audio.

Dari hasil pengujian yang
kami lakukan, motherboard ini
memiliki kinerja yang cukup
lumayan. Produk XFX KT400-ALH
ini dapat menyelesaikan semua
uji dengan baik tanpa menemui
masalah sama sekali. Hal ini
tentunya mudah didapat, karena
ketika kami periksa system clock
dan system bus-nya, system clock
bekerja pada 166,0MHz,
sedangkan system bus-nya
berjalan pada 332,0MHz.

Motherboard XFX KT400-
ALH ini kami uji dengan prosesor
AMD Athlon XP 3000+ yang
memiliki bus 166 DDR dengan
clock speed 2,167GHz, dua

keping memori DDR-SDRAM PC-
3200 yang masing masing
berkapasitas 256MB dari Corsair,
kartu grafis Gigabyte Radeon
9600Pro 128MB, dan harddisk
Seagate Barracuda ATA IV
7200rpm kapasitas 40GB. Sistem
operasi yang kami pasang
adalah Windows XP Profes-
sional  dengan software
benchmark Sysmark2002,
Sisoft Sandra 2003, Quake 3
Arena, dan 3DMark2001. Hasil
selengkapnya dapat Anda simak
pada tabel berikut. (fmn)

ARE/PCplus

Creative yang
selama ini dikenal
sebagai produsen kartu suara
dan speaker ternama ternyata
memiliki beberapa produk
unggulan lain. Salah satu
produk mereka adalah
kartu grafis. Untuk bidang
yang satu ini, seri teranyar
yang mereka perkenalkan
adalah seri 3D Blaster 5
series yang kebanyakan
varian produknya
mengusung chip
pemrosesan grafik
bikinan ATI.

Salah satu
jajaran produknya
yang datang ke
lab PCplus
adalah seri
RX9600 Pro,
yang
mengusung chip
ATI Radeon 9600 Pro.
Spesifikasi teknis yang
ditawarkan produk  yang sudah
menggunakan interface AGP 8X
ini cukup menjanjikan. Dengan
mengusung kecepatan
pemrosesan (GPU, graphical
processing unit) sebesar
398,25MHz dan kecepatan
memori sebesar 297MHz,
RX9600 Pro yang digolongkan
untuk kelas mainstream ini
cukup menjanjikan. Apalagi
dengan dukungan memori
buffer kelas double data rate
sebesar 128MB, produk yang
sudah dioptimalkan untuk
penggunaan directX 9.0 dan

OpenGL terbaru ini ini
pastinya sudah sangat mampu
mendukung aplikasi-aplikasi yang
lumayan berat.

Fitur yang diusung produk
yang menggunakan heatsink fan
sebagai pendingin chip utamanya
ini tergolong standar. Interface
yang digunakan selain port D-Sub
untuk interface ke monitor
standar, disediakan pula sebuah
konektor video out yang dapat
dihubungkan dengan perangkat
multimedia lainnya. Seperti juga
pada kartu grafis modern
lainnya, RX9600 Pro ini
menyediakan pula sebuah
konektor DVI out untuk koneksi

ke monitor LCD.
Dari pengujian, PCplus

mendapatkan kartu grafis  yang
memiliki 4 rendering pipeline
paralel dan 2 geometry engine
paralel mampu menghasilkan
resolusi maksimal sebesar
2048x1536 dengan refresh rate
sebesar 66Hz.  Sementara, ketika
resolusi pada 1024x768, refresh
rate yang bisa digunakan bisa
mencapai 120Hz.

PCplus menguji produk yang
berwarna dasar merah ini dengan
menggunakan Asus nForce2
dengan prosesor Athlon XP
2000+, memori Corsair XMS

3D Mark 2001
1024 x 768  16bit :10120
1024 x 768  32bit :9792
1280 x 1024  16bit :8352
1280 x 1024  32bit :8159
1600 x 1200  16bit :6669
1600 x 1200  32bit :6282

3D Mark 2003
1024 x 768 :3324
1280 x 1024 :2426
1600 x 1200 :1748

Quake III Arena
1024 x 768  16bit :223,6
1024 x 768  32bit :217,4
1280 x 1024  16bit :184,3
1280 x 1024  32bit :168,4
1600 x 1200  16bit :125,9
1600 x 1200  32bit :116,3

3200 dua keping yang
masing-masing berkapasitas
256MB, harddisk Barracuda
ATA IV 7200rpm 40GB,
power supply Enlight 420W,
dan monitor Samsung
SychMaster 900NF. Driver
yang digunakan adalah ATI
Radeon Catalyst 3.4. Seperti
biasa, software penguji yang
digunakan adalah 3Dmark
2001, Quake 3 Arena Demo,
dan 3Dmark 2003. Software

bantuan yang dipakai lainnya
adalah PowerStrip 3.40.

Hasil yang diperoleh produk
ini pada 3 software penguji
menunjukkan performa yang
lebih baik untuk semua bidang
pengujian dibanding dengan 2
produk sejenis yang telah diuji
sebelumnya dengan
menggunakan test bed yang
sama. Hanya saja, skornya masih
sedikit di bawah untuk pengujian
3Dmark 2001 pada resolusi
1024x768 32bit. Namun, untuk
pengujian yang lain, skor produk
ini masih sedikit lebih unggul.

Pada kemasan jualnya,

ARE/PCplus

Creative juga menyertakan
sebuah kabel penghubung port
S-Video out dan sebuah CD
driver. Sayangnya, buku
manual yang disertakan
tergolong amat sederhana dan
kurang lengkap. (sil)
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PT Acer Indonesia
www.acerindonesia.com

☎ (021) 5702226
1100 dolar AS

Aspire Veriton 7600G:

PC Berbasis Chipset
Terbaru
Untuk memenuhi
permintaan pasar
akan PC dengan basis sistem
terbaru, Acer terus melakukan
inovasi dengan membangun
sistem yang sesuai dengan
kebutuhan user. Pada
segmentasi office, Acer merilis
produk terbarunya, Veriton
7600G.

Seri Veriton kali ini adalah
sebuah PC yang menggunakan
chipset Springdale-G atau
i865G. Untuk kali ini, prosesor
yang dipasang adalah Intel
Pentium-4 2,6GHz yang sudah
menggunakan FSB 800MHz.
Mode dual channel memory
yang didukung pada sistem ini
adalah menggunakan dua
keping memori DDR400,
DDR333, 266. Board
menyediakan slot DDR
sebanyak empat buah,
sedangkan memori yang
disediakan oleh Acer adalah
dua keping memori DDR400
yang masing-masing memiliki
kapasitas sebesar 128MB.

Selain menawarkan VGA
onboard, yang share memory-nya
bisa diatur lewat BIOS, pada
board juga tersedia sebuah slot
AGP yang sudah mendukung AGP
8x. Tiga buah slot PCI juga
disediakan jika penggunanya
ingin memasangkan perangkat
add-on lainnya.

Untuk melengkapi PC ini,
fasilitas USB hingga enam buah

port,
audio,
dan
Gigabit
LAN sudah
diinte-
grasikan.
Untuk me-
mudahkan

dalam
peng-
gunaan
perangkat

USB, pada
bagian depan

casing tersedia dua buah
port, disamping port untuk

audio dan microphone. PC ini
juga dilengkapi dengan sebuah
CD-writer dan monitor tabung/
CRT 17 inci. Dengan
menggunakan monitor ini pada
resolusi 1024x768, tingkat refresh
rate 85Hz sudah cukup nyaman
digunakan untuk bekerja.

Fitur yang menarik dari Acer
Veriton 7600G ini adalah
tersedianya fungsi one touch
recovery button. Bila terjadi

kerusakan pada registry, sistem
operasi atau ada file-file yang
terhapus yang menyebabkan
sistem tidak bekerja secara
normal, pengguna hanya perlu
menekan satu tombol agar sistem
kembali ke kondisi awal seperti
baru selesai diinstalasikan. Data-
data dan software lain yang
pernah diinstalasikan di drive C:\
memang akan hilang, namun
back-up-nya yang disimpan di
drive D:\ tetap aman.

Utility ini secara otomatis
melakukannya tanpa perlu
membutuhkan CD atau driver
apapun. Tentunya lebih mudah
dan praktis. Fitur ini juga dapat
dipasangi password untuk
mencegah pengguna yang tidak
berhak untuk melakukan restore.

Fungsi lain yang tentunya
cukup berguna untuk pengguna
kantoran adalah Acer LANScope.
Software ini merupakan aplikasi
untuk pengaturan setting
desktop, informasi mengenai
komponen yang digunakan, ja-
ringan, ataupun koneksi Internet.

Secara keseluruhan, Aspire
7600G sudah sangat mencukupi
kebutuhan. Kemampuan upgrade
yang dapat didukung,
tersedianya sarana untuk media
penyimpanan masa depan yang
lebih cepat, membuat Acer
Veriton 7600G ini cocok untuk
dijadikan PC kerja yang menarik
untuk digunakan dalam jangka
waktu yang cukup panjang.

PCMark 2002
CPU Score :6327
Memory Score :7022
HDD Score :831

SisoftSandra 2003
ALU :8109 MIPS
FPU :2135 MFLOPS
ISSE2 :4797 MFLOPS

3D Mark 2001
640 x 480  16bit :3914
1024 x 768  32bit :2742

WCPUID
System Clock :199,53MHz
System Bus :798,14MHz
Internal Clock :2593,94MHz

Garansi yang diberikan yaitu
selama 3 tahun juga tentunya
merupakan nilai tambah
tersendiri.

Agar lebih lengkap, ulasan
kali ini kami sertai pula dengan
hasil pengujian untuk performa
PC Acer Veriton 7600G. Soft-
ware uji yang kami gunakan kali
ini adalah PCMark 2002 dan
3DMark 2001 dari MadOnion,
SiSoft Sandra 2003, serta
WCPUID 3.1a untuk
mengetahui clock dan FSB
sistem sebenarnya. Sistem
operasi yang kami gunakan
adalah Windows XP Profes-
sional yang sudah dibundel
dengan PC Acer ini. (fmn)
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Wajar apabila sang
kakak –Adobe

Photoshop- sudah
terkenal sebagai part-

ner andalan para
fotografer maupun

desainer grafis.  Kali
ini, redaksi mencoba
mencoba kebolehan
“sang adik” – GIMP

GNU Image Manipu-
lation Program-

dalam menyunting
citra, termasuk foto

(lihat Gambar 1).

TIGA SENJATA UTAMA:
LAYER, MASKING DAN
CHANNEL

Tiga kekuatan inti Adobe
Photoshop dimiliki juga oleh
GIMP. Kita yang sudah
memahami asas kerja ketiga
unsur inti tersebut di Photoshop
tidak akan menemui kesulitan
sama sekali ketika menggunakan
fasilitas ini di GIMP. Bahasan
ketiga fasilitas ini dalam
Photoshop ada di rubrik

GIMP:
Menakar Ketangguhan Sang “Adik”

Adobe Photoshop (Bagian 1)
Vincent Bayu Tapa Brata

vincent@e-pcplus.com

PlusSoftware PCplus edisi
133-139.

Akses terhadap ketiga
fasilitas inti GIMP dengan klik
tombol kanan mouse pada
bidang kerja, lalu pilih menu
[Layers] > [Layers, Channels
and Paths] (lihat Gambar 2).
Pilihan-pilihan (sub-submenu)
yang ada pada masing-masing

fasilitas ini juga sama dengan
yang ada di Photoshop, misalnya:
Duplicate Layers, Channel to
Selection, Path to Selection.
Hanya saja, Add Layer Mask
yang di Photoshop merupakan
ikon menyatu dengan palet
Layer, di GIMP harus diakses
dengan klik kanan pada bar layer
yang bersangkutan dan memilih
Add Layer Mask (lihat Gambar 3).

Tingkat transparansi
(opacity) layer bisa diatur lewat
palet Layer dengan menggeser

slider Opacity.  Sementara itu,
Opacity masing-masing tool
(misalnya Paintbrush) dapat
diatur dengan klik ganda
masing-masing tool dan
menggeser slider Opacity
(intensitasnya) (lihat Gambar 4).
Performa kerja fasilitas layer
bertambah dengan
disertakannya berbagai mode
pengatur penyatuan suatu layer
dengan layer lainnya (di
PhotoShop kita kenal dengan
Transfer Mode), misalnya:
Overlay, Multiply, Screen,
Difference, dan lainnya (lihat
Gambar 5).

Delete Layer Mask,
Flatten Image (menyatukan
berbagai layer), diakses dengan

klik pada bar layer yang
bersangkutan. Fasilitas
Channels bisa dimanfaatkan
untuk membuat seleksi
(pemisahan) terhadap subjek-
subjek gambar yang bentuknya
kompleks, misalnya: rambut,
cipratan air, riak air, dan
refleksi.

PENYUNTING WARNA
Penyunting warna yang

disediakan GIMP antara lain:
Levels, Curve, Color Balance,
Brightness-Contrast,
Hue-Saturation, Treshold,
Desaturate (mengubah gambar
menjadi hitam-putih tanpa
mengubah mode warna dari
RGB), Invert (negatif), Posterize,
dan lainnya (lihat Gambar 6).
Fasilitas-fasilitas ini dapat diakses
dengan klik kanan di bidang
kerja dan memilih menu
[Image]>[Colors].  Fasilitas
Channels yang disebut
terdahulu juga bisa
dimanfaatkan untuk
menyunting warna, misalnya
menonjolkan warna-warna
tertentu.

PENGUBAH UKURAN,
POSISI, PERSPEKTIF DAN
PENYEDERHANA
KOMPOSISI (CROP)
GAMBAR

Tiga hal ini merupakan
fasilitas yang tidak kalah penting
dalam penyuntingan gambar.
Scale (pengubah ukuran),
Rotate (pemutar posisi), dan
Perspective (di Photoshop
adalah Skew) dapat diakses
dengan klik ganda Rotation,
Scaling, Shearing and
Perspective Tool di Toolbox
(lihat Gambar 7).

Minggu depan, PCplus
akan melanjutkan ulasan ini
sampai tuntas.

Sampai jumpa! PC+

Gambar 1

Gambar 2 Gambar 7

Gambar 4

Gambar 3

Gambar 5

Gambar 6
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Pengenalan
GNUPG (Bagian 3)

Willy Sudiarto Raharjo
willy@e-jogja.net

J

Kita juga diberi
kesempatan untuk

mengedit kunci publik
milik kita sendiri

maupun milik orang
lain. Beberapa pilihan

penting yang harus
kita cermati adalah
trust dan sign. Trust

merupakan tingkatan
kepercayaan kita

terhadap kunci publik
milik teman untuk
bertindak sebagai

pengenal terhadap
kunci lain yang

mungkin akan Anda
terima di masa

mendatang.

ika suatu saat
Anda mendapatkan
kunci asing yang sudah
di-sign oleh orang yang

sudah Anda percayai (misalnya
teman Anda, dengan memberikan
trust yang tinggi), maka kunci
asing tersebut akan dianggap valid
meskipun Anda tidak melakukan
pengujian, karena sudah

mendapatkan semacam
rekomendasi dari teman tersebut.
Sign adalah semacam tanda
tangan yang membuktikan bahwa
kita sudah yakin bahwa kunci
publik tersebut merupakan kunci
publik yang valid.

SIGN DAN TRUST
Untuk dapat mulai

melakukan pengeditan kunci
publik, berikan perintah gpg --
edit-key <user> , di mana user
adalah identitas dari user, yang
bisa berupa nama, e-mail, maupun
komentar. Pada Gambar 1,
terlihat bahwa identitas yang
digunakan adalah nama e-mail
yang bersangkutan. Setelah
memberikan perintah tersebut,

maka akan muncul
prompt command >
yang berarti GnuPG
siap menerima
perintah dari kita.
Terdapat beberapa
perintah yang dapat
kita berikan, namun
pada tulisan ini hanya
akan dibahas tiga
saja, yaitu sign,
trust, dan check.
Perintah-perintah
selengkapnya bisa
Anda lihat dari
manual gpg (man
gpg).

Mari kita coba
untuk memberi signature pada
kunci publik milik teman kita (dalam

contoh ini adalah
dosen penulis).
Setelah muncul
prompt command
>, maka kita bisa
berikan perintah
sign, yang akan
dilanjutkan dengan
beberapa
pertanyaan.
Pertanyaan pertama
adalah apakah kita
akan memberi
signature pada
semua user id. Pada
umumnya, kita akan
menjawabY.
Selanjutnya, akan
ditanyakan apakah
signature kita akan
kadaluarsa setelah
waktu expire dari
kunci publik berakhir.
Pertanyaan ini hanya
akan muncul jika
kunci publik yang
dibuat mempunyai
batas kadaluarsa. Jika
kita ingin agar
signature kita
berlaku selamanya,
maka pilihlah Y.

Pertanyaan
ketiga adalah
tentang kesiapan

Anda dalam memeriksa keabsahan
dari kunci publik milik rekan Anda.
Pertanyaan terakhir adalah
konfirmasi apakah
Anda benar-benar
ingin membubuhkan
signature Anda pada
public key ini.
Jawablah dengan Y,
maka setelah Anda
memasukkan
passphrase, maka
public key akan
dibubuhi dengan signature
Anda. Setelah Anda
memberikan signature, Anda
bisa keluar dengan perintah
quit atau save untuk
menyimpan perubahan yang
telah Anda buat. Perintah

quit secara otomatis akan
menanyakan apakah Anda akan
menyimpan perubahan atau tidak.
Lebih baik Anda melakukan
penyimpanan setiap kali Anda
selesai melakukan suatu proses.

Pada contoh berikutnya, kita
akan melihat bagaimana
memberikan tingkatan trust pada
public key milik teman kita.
Setelah masuk ke prompt com-
mand > kita berikan perintah
trust, maka akan dilanjutkan
dengan berbagai pertanyaan dan
pilihan seperti pada perintah
sign. Pertanyaan pertama akan
meminta Anda untuk memilih
tingkat kepercayaan Anda
terhadap kunci publik ini
(Gambar 2). Jika Anda sangat
mempercayai, maka pilihlah 5,
tetapi jika Anda agak kurang
percaya, maka Anda bisa memilih
3, dan seterusnya. Setelah Anda
memilih tingkat kepercayaan,
maka akan ditampilkan
pertanyaan konfirmasi yang
menanyakan apakah Anda benar-
benar akan memberikan tingkat
kepercayaan tersebut. Jawablah
dengan Y untuk memberikan
tingkat kepercayaan yang sudah
Anda tentukan.

Perlu diingat bahwa
perubahan terhadap trust hanya
berlaku setelah Anda keluar dari
program dan memanggil kembali
user ID yang bersangkutan. Sebagai
bukti, sebelum Anda keluar, maka
nilai trust hanya akan bernilai u/-,

sedangkan setelah Anda keluar dan
melakukan pengeditan lagi, maka
nilai trust-nya akan berubah
menjadi u/u.

Untuk melihat siapa saja yang
telah memberikan signature pada
public key, kita bisa menggunakan
perintah check. Kita bisa tahu
bahwa setiap kali kita menciptakan
sebuah pasangan kunci, maka kita
akan memberikan signature pada

public key kita sendiri. Buktinya
adalah adanya tanda [self-signa-
ture].

INTEGRASI
DENGAN EMAIL
CLIENT

Setelah kita
berurusan dengan
public key, maka
saatnya kita mencoba
integrasinya dengan e-
mail client yang cukup
terkenal di Linux, yaitu
KMail.  KMail datang
dengan paket KDE
yang merupakan
standar dalam distro
Mandrake Linux dan
Redhat Linux. Versi
terakhir KMail saat
penulisan tulisan ini
adalah 1.5. Untuk bisa
mengaktifkan pilihan
melakukan enkripsi
dan pembubuhan
signature pada setiap
pesan e-mail, kita
harus mengaktifkan
pilihan Encryption
Tools yang bisa
didapatkan dengan
memilih menu
Setting>Configure
KMail, lalu dilanjutkan
dengan memilih tab
Security (Gambar 3).
Dalam Encryption Tools, terdapat
beberapa pilihan, seperti Auto
Detect, GNU Privacy Guard, PGP
2x, PGP 3x, dan sebagainya.
Namun, karena di sini kita
menggunakan GnuPG, maka kita
set ke GNU Privacy Guard seperti
pada gambar. Di bagian bawah
terdapat beberapa pilihan yang bisa
mempermudah kita dalam
melakukan proses pengiriman
maupun enkripsi.

Ketika mengirimkan sebuah
pesan e-mail kepada rekan kita
yang public key-nya sudah

tersimpan dalam database GnuPG,
maka setelah Anda menekan
tombol [Send], akan muncul
dialog seperti pada Gambar 4
yang menanyakan apakah Anda
ingin melakukan enkripsi atau
tidak (pembubuhan signature
sudah pasti akan dilakukan karena
sudah diset pada Option).

Setelah memilih salah
satunya, maka akan muncul dialog

untuk menuliskan
passphrase Anda,
seperti pada
Gambar 5. Jika
Anda memilih
untuk
menggunakan
enkripsi, maka
setelah
memberikan
passphrase, KMail
akan

menunjukkan informasi kunci
yang akan digunakan, seperti
pada Gambar 6. Gambar 7
adalah contoh dari e-mail yang

dikirimkan tanpa menggunakan
enkripsi, sedangkan Gambar 8
adalah contoh yang
menggunakan enkripsi. Gambar
9 adalah contoh e-mail yang
mengandung informasi public key,
tetapi kita tidak mempunyai public
key orang tersebut. Karena kita
tidak mempunyai informasi me-
ngenai public key orang tersebut,
maka validitas dari signature
tersebut tidak dapat kita verifikasi.

Public key penulis, bisa
diminta via email willy@e-
jogja.net. PC+

Gambar 1

Gambar 2

Gambar 3

Gambar 4

Gambar 5

Gambar 6

Gambar 7

Gambar 8

Gambar 9
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Linux Makin Diminati
Kalau diperhatikan,

sebenarnya
masyarakat Indonesia

sudah mulai
menghargai karya

orang lain. Terbukti,
dengan

diberlakukannya UU
HaKI, para pedagang
mulai takut menjual

barang bajakan,
banyak pengguna

komputer yang mulai
beli software original,

walaupun sweeping
barang bajakan tidak

dilakukan secara
gencar.

endengar
beberapa pengguna
komputer di kota-kota
besar di Indonesia

sudah mendapat gugatan
hukum mengenai penggunaan
software bajakan, ternyata
diam-diam banyak pengusaha
yang sudah mengimplementasi-
kan penggunaan Linux di
kantornya. Hal ini terungkap
pada seminar yang
diselenggarakan oleh IBM pada
tanggal 21 Agustus 2003 lalu di
Hotel Sheraton, Surabaya
dengan tajuk “Open Your
Mind to Open Computing
with Linux, supported by
IBM”.

Menurut Betti
Alisjahbana, Presiden
Direktur PT IBM Indonesia,
sejak tahun 1997 IBM telah
menyatakan komitmennya
untuk mendukung Linux. “Pada

M

awalnya Linux memang hanya
dipakai untuk fungsi-fungsi dasar
seperti “file server” dan “e-mail
server”, tapi sekarang sudah jauh
berkembang untuk fungsi-fungsi
yang lebih luas, seperti keperluan
perkantoran, akunting, web ser-
vicing, dan lain-lain,” ujar Betti.

Tidak tanggung-tanggung,
sepanjang tahun 2001 saja IBM
telah menginvestasikan sekitar
US$ 1 miliar untuk mengem-
bangkan produk dan jasa yang
berkaitan dengan Linux. Selain
itu, tidak kurang dari 5000
profesional di IBM terlibat dalam
penelitian, pengembangan,
pemasaran, dan penjualan
produk-produk Linux di IBM.

Sejarah Singkat Linux
Linux pertama kali dibuat

oleh Linus Torvalds, seorang
mahasiswa yang berasal dari
Helsinki, Finlandia. Linus
membuat Linux karena
terinspirasi oleh Minix, sebuah
sistem UNIX kecil yang
dikembangkan oleh Andy
Tanenbaum. Linux versi 0.01
dikerjakan sekitar bulan Agustus
1991. Kemudian pada tanggal 5
Oktober 1991, Linus
mengumumkan versi resmi Linux,
yaitu versi 0.02. Sampai saat ini
Linux sudah berkembang
sedemikian rupa dan mempunyai
beberapa varian seperti Red Hat,

atau Linux Sehat yang bisa Anda
download dari
www.ictwatch.com.

Tampaknya penggunaan
Linux semakin luas dan cepat.
Bahkan menurut Michinori
Nakahara, Direktur Pemasaran
dan Penjualan Linux IBM Asia
Pacific, perkembangan Linux di
Asia jauh lebih cepat dibanding-
kan di negara-negara Barat. Na-
kahara menunjuk Jepang, Korea
Selatan, Cina, dan India sebagai
pendukung terkuat sistem ope-
rasi Linux dan melihat potensi
yang sangat besar bagi penelitian
dan pengembangan aplikasi bis-
nis berbasis Linux di kawasan ini.
Di Indonesia sendiri pengembang
aplikasi berbasis Linux juga sudah
mulai bermunculan.

Siapa yang Harus
Bermigrasi?

Tentu tidak semua orang bisa
langsung bermigrasi ke Linux.
Bagi pengguna komputer yang
hanya menggunakan komputer
untuk fasilitas perkantoran
seperti mengetik surat,
penanganan database, atau
akuntansi, bisa langsung
bermigrasi menggunakan Linux.
Anda bisa saja menggunakan
Open Office atau Star Office
sebagai pengganti Microsoft
Office. Sementara sistem operasi
berbasis Linux seperti Lindows

sudah mempunyai aplikasi ba-
waan yang cukup lengkap. De-
ngan menginstall Lindows, Anda
sudah dapat membuat CD, me-
mutar lagu MP3, memutar VCD,
bahkan Anda juga bisa membaca
file-file lama Anda
yang dibuat oleh
Microsoft Office
tanpa kesulitan.

Tapi jika Anda
pengguna komputer
yang agak serius
seperti desainer
grafis, tentu masih
harus berpikir lebih
panjang untuk
bermigrasi. Karena
walaupun sudah ada
program pengolah
grafis di Linux,
namun sangat jauh
jika Anda
bandingkan dengan
Adobe Photoshop
misalnya. Walau
begitu, namun masih
ada solusi jika Anda
ingin menggunakan sistem
operasi selain Windows.

Sistem operasi Windows
memang mempunyai kelebihan,
yaitu dukungan dari pembuat
software ternama seperti Adobe,
Macromedia, dan lain-lain. Ba-
nyak games yang memang dibuat
untuk Windows. Jadi jika Anda
membeli Windows 98 SE original

yang berharga sekitar US$ 70,
itu bukanlah hal yang sia-sia.

Tapi jika Anda ingin
mengikuti tren perkembangan
sistem operasi yang lain dan kini
menunjukkan mendapat

dukungan pemain-pemain di
industri komputer yang kuat,
Anda bisa mengikuti seminar
“Migrasi dari Windows ke
Linux” yang rencananya akan
diselenggarakan pada akhir
bulan September di Jogja dan
Surabaya. Tunggu saja kabar
dari kami dan simak terus
informasinya! (din)
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UGM - JOGJAKARTA

27 - 28 September 2003

Materi :

• Dasar-dasar Video Editing
• Capture video ke komputer
• Membuat VCD
• Tip & Trik video editing dengan
  Adobe Premiere 6.0

KIT workshop •
Modul materi workshop •

Coffee Break •
Sertifikat •

Fasilitas:

Pendaftaran:
- Sdr. Oesep Kurniadi - Tlp: (0274) 563172
- Sdr. Aris - Hp. 08179409911

Biaya: Rp. 200.000,- (umum)
           Rp. 150.000,- (mahasiswa)

Fakultas MIPA - Jurusan Fisika
(Prog.Studi Elektronika & Instrumentasi)

Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga Dalam Dolar AS

MOTHERBOARD

VIA P4PB-Ultra+RAID  P4X400,
ATX, FSB533, DDR333/400, RAID 103
VIA P4PB400-L  P4X400,
ATX, FSB533, DDR333/400 68
VIA P4PB266EN, P4X266,
ATX, FSB 533, 3 DDR 68
VIA P4MA-Pro, Via P4M266,
M-ATX, FSB 400, VGA, LAN 59

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 105
Asus P4PE/L 1394, i845PE, AGP4X,
DDR, 6PCI, USB2.0,
Hyper-threading 133
Asus P4PE/L , i845PE, AGP4X, DDR,
6PCI, USB2.0, Hyper-threading 100
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 236
Asus P4P800 Deluxe, i865, FSB 800,
ATA100, 4DDR 174
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800,
4DDR, RAID, LAN, audio 164
Asus P4C800, i875, FSB800,
4DDR, RAID, Audio, Gigabit LAN 210
Asus P4B533, i845E, FSB533,
ATA100, 3DDR, audio 84

Asus P4B533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 79
Asus P4S8X/L 1394, SiS648,
FSB533, 3DDR, AGP8x, audio,
Serial ATA, 1394 131
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 89
Asus P4S533-X, SiS645dx,
FSB533, 2DDR, audio,
VGA onboard 70

Asus A7V8X/L 1394, KT400,
ATA133, AGP8x, FSB266,
3DDR, audio,
LAN, 1394 126
Asus A7N8X Deluxe/GD, NForce2,
ATA133, 5 PCI, 3DDR,
audio dolby, AGP8x 161
Asus A7N8X Deluxe, NForce2,
ATA133, 5 PCI, 3DDR, audio dolby,
AGP8x 168
Asus A7N8X/L, NForce2, ATA133,
5PCI, 3DDR, Codec, LAN, 1394 116

APLUS AP973, i845G, FSB 533MHz,
2DDR, Intel Graphic, ATX, AC97 76
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 76
APLUS AP978 Ii845GL, ATX, 400FSB,
SOUND AC97, 2 SDRAM 54
APLUS AP971A+ VIA P4M266, ATX,
400FSB, SOUND AC97, 2 SDRAM,
S3 Savage4 4XAGP 50
APLUS AP976E2, VIA P4X266E,
FSB 533MHz, 2DDR,
M- ATX, AC’97                               50

APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A2 VIA P4M266A,
ATX, 533FSB, SOUND AC97, 2DDR 52
APLUS AP971A VIA
P4M266A, M.ATX, 533FSB,
SOUND AC97,
2SDRAM 50
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60
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KURSUS

DIKLAT KOMPUTER BERSERTIFIKAT  Rp.100.000,-
1.Teknik Komputer+MoBo+Hardisk+CopyBios
2.Network LAN+EDP+Admin+PC Kloning
3.Design Grafis 4.Private + Jarak jauh OK
Gratis : CD-Modul-Sertifikat-Drink-Konsultasi

DIKLAT JARINGAN PC KLONING TANPA HARDISK
Komp lama bisa secepat P.4 - RAM 8 jadi 64
Belajar Jarak Jauh Bisa -  Bergaransi
EXSYSCOM:021.78889003 - 0815.997.1234
Jl.Raya Depok-Depan UI-Blk Halte-Jakarta 12640

IT Asy-syifa Bljr 5 Dri 2-5 Hari
Teknisi 1. Komp+Mobo+Copy Bios 70Rb 2. Moni-
tor 70Rb Software 3. Prog. VB.v6 65Rb 4.SPSS
V.11 95Rb.Sabtu-Ahad Tek.LAN+PC Cloning 60Rb.
Jl.Akses UI  Dkt Gd.E Gunadarma Kelapa Dua Depok
Tlp.021-920-2459

IZZAH COM Kursus ‘PAKET HEMAT’ Merakit PC
75rb LAN 75rb  WebDesign 150rb Photoshop 85rb
MS.Office 85rb Pwr.Point 75rb
Praktis,Cpt,certificate.Jl.Rawamangun Timur/78
Ph.47867273 http://izzahcomp.tripod.com

LAIN-LAIN

LENGKAP & MEMUASKAN
- Bubuk TONER MURNI dari pabrik
- OPC drum, blades, mag roller, dll

- Larutan Kimia untuk rekondisi
- Tinta literan INKJET MURNI

- Refill tool, resetter, accessories, dll
TERSEDIA BAGI PEMULA :

Paket bisnis isi ulang & training
www.ecoprintlution.com
(031) 501 6088, 504 0150

W W W . R A J A N O T E B O O K . C O M
(021 )5689393  -  08129283447
Pusat Notebook Bekas Berkualitas
R e a d y  S t o k  S e t i a p  H a r i
Tersedia IBM, Toshiba dan Dell

INGIN JAGO BIKIN WEB? gunakan CD SmartPHP, solusi
lengkap belajar sendiri bikin website dinamis,
 GRATIS untuk 100 member awal yg bergabung.
 Dapatkan pula penghasilan jutaan/bulan. Visit
 http://peluang.earthweb.biz (0811831835-Harris)

G r a t i s . . . !  3  C D  L i n u x  &  P a n d u a n
V i s u a l  “  M e n g g u n a k a n  L i n u x ”
S e m u d a h  M e n g g u n a k a n  W i n d o w s .
P C  L I N U X  -  0 8 1 3  1 0 6 5  0 5 9 0  h t t p : / /
p c l i n u x . 2 y a . c o m /

IKLAN BARIS

MSI 645Combo, SiS 645, ATX, FSB533,
2DIMM, ATA133, AGP4X, 6PCI 66
MSI 645E MAX-U, SiS645DX, ATX,
FSB533, 3DIMM, ATA133, AGP4X, 6PCI 73
MSI 651M COMBO-L, SiS 651, m-ATX,
FSB533, 2DIMM, ATA133, AGP4X 76
MSI 648 MAX, SiS 648x, ATX, FSB533,
3DIMM, ATA133, AGP8X, 6PCI 88
MSI 655 MAX FISR, SiS655, ATX,
FSB533, 4DIMM, ATA133,
SATA, AGP8X 160
MSI 655 MAX LS, SiS655, ATX,
FSB533, 4DIMM, ATA133,
SATA, AGP8X 110
MSI 645GLM, I845gl, Matx, FSB400,
2DIMM, ATA100, AGP4X, 3PCI 73
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 96
MSI 865PE Neo2, I865pe, ATX, FSB800,
2GBDDR, ATA133, AGP8X, 5PCI 130
MSI 845PE Max2-FISR, i845PE,
ATX, FSB533, 2GBDDR, ATA133,
AGP4X 163
MSI K7N2-L, nForce2, ATX, FSB400,
3GB DDR, ATA133, AGP8X, 5PCI 115
K7N2G-L, nForce2, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 5 PCI 130
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 85
KT4V Ultra FISR, Via KT400, ATX,
FSB333, 3GBDDRR, ATA133, SATA 158

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 77
Gigabyte GA-7VA, VIA KT400, ATX,
Soket A, ATA133 89
Gigabyte GA-7N400-L1, nForce2 ultra,
ATX, Soket A, ATA133, Raid, Firewire 112
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-8SG800,  SiS 648,
ATX, FSB800, ATA133, AGP8X, 5PCI 82
Gigabyte GA-8ST800, SiS 645DX,
ATX, FSB800, ATA133 73
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 187
Gigabyte GA-8IE800, i845E,ATX,
FSB533, ATA100 87
Gigabyte GA-8IPE1000, i865PE,
ATX, FSB800, 4DDR, 5PCI 132
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 107
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133,
AGP pro 242

Jetway J-603TCF, VIA PLE33,
soket 370, M-ATX, FSB100, ATA100 52
Jetway J-P4XFBU, VIA P4X266E,
soket 478, ATX, FSB533, ATA133 62
Jetwat J-615TCS, i845E, soket 370,
M-ATX, FSB133, ATA133 56
Jetway J-615TCF, I845e, M-ATX,
soket 370, FSB133, ATA133 81
Jetway J-830CH, SiS730SE, ATX,
soket 462, FSB266, ATA100 63
Jetway J-P4MDPT, VIA P4M266A,
M-ATX, soket 478, FSB533, ATA133 64
Jetway J-S446, SiS645/961, ATX,
soket 478, FSB400, ATA100 66
Jetway J-845EPRO+ RAID, i845E,
ATX, soket 478, FSB400/533, ATA133 90
Jetway J-845GLM, i845GL, M-ATX,
soket 478, FSB/400, ATA100 67

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 80
Iwill P4E, i845PE, soket 478,
FSB 400/533, DDR, Audio,
F1 series, ATA133 & 100 76
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing,
SCSI 999

Soyo K7V Dragon Ultra. VIA KT333,
6ch audio, AGP Pro, LAN10/100 145
Soyo K7V Dragon Lite. VIA KT333,
6ch audio, AGP 4x 85
Soyo P4X400, VIA P4X400, RAID,
6ch audio, AGP PRO, 6 PCI 155
Soyo P4I Fire Dragon, i845D, DDR266,
RAID, 6ch audio, AGP PRO, 6 PCI 120
Soyo P4S Dragon Ultra,
Sis645A2+961, RAID, 6ch audio,
AGP PRO, 6 PCI 140
Soyo P4IS2, i845, SDRAM, AC97,
6PCI, AGP4X 60

Abit IC7  i875P, FSB800MHz, 4 DDR,
AGP 8X, 5 PCI 145
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 103
Abit BE7-G, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 127
Abit BE7-S, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 117
Abit BG7, i845G, FSB 533MHz,
3DDR, AGP 4X, 5 PCI 126
Abit BG7E, i845GE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 100
Abit TH7 II RAID, i850, FSB 400MHz,
4 RIMM, AGP 4X, 5 PCI 149
Abit SR7-8X, SiS 648, FSB 533MHz,
3 DDR, AGP 8X, 5 PCI 95
Abit SD7-533, SiS 645, FSB 400MHz,
3 DDR, AGP 4X, 5 PCI 95
Abit SA7, SiS 645DX, FSB 533MHz,
3 DDR, AGP 4X,  5 PCI 75
Abit AT7 Max, Via KT333,
FSB 266MHz, 2 DDR, AGP 4x, 3 PCI 150
Abit AT7 Max II, Via KT400,
FSB 266MHz, 2 DDR, AGP 8X,  5PCI 181
Abit KD7, Via KT400, FSB 333MHz,
4DDR, AGP 8X, 6 PCI 87
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 97
Abit NF7-M, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 123

MEMORI

Visipro 128MB (4 IC) PC 133 25
Visipro 128MB (8 IC) PC 133 33
Visipro 256MB (8 IC) PC-133 45
Visipro 256MB (16 IC) PC-133 67
Visipro 512MB PC-133 82
Visipro 128MB (8 IC) PC-2100 28

Visipro 256MB (8 IC) PC2100 50
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 94
Visipro 128MB (4 IC) PC-2700 Call
Visipro 128MB (8 IC) PC-2700 29
Visipro 256MB (8 IC) PC2700 53
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 99
Visipro 256MB PC3200 (8IC) 56
Visipro 512MB PC3200 102
Visipro 64MB PC800 36
Visipro 128MB PC800 (4IC) Call
Visipro 256MB PC800 (8IC) 105

Nexus SDRAM PC-133 64MB 15.5
Nexus SDRAM PC-133 128MB 20.5
Nexus SDRAM PC-133 256MB 37
Nexus DDR PC-2100 128MB 23
Nexus DDR PC-2100 256MB 42.5
Nexus DDR PC-2700 256MB 44.5
Nexus DDR PC-2700 512MB 90

V-Gen SDRAM PC-133 (8IC) 64MB 16
V-Gen SDRAM PC-133 (4IC) 128MB 22
V-Gen SDRAM PC-133 (8IC) 128MB 31
V-Gen SDRAM PC-133 (8IC) 256MB 41
V-Gen SDRAM PC-133 (16IC) 256MB 61
V-Gen SDRAM PC-133 (16IC) 512MB 83
V-Gen DDR PC-2100 (8IC) 128MB 24
V-Gen DDR PC-2100 (8IC) 256MB 46
V-Gen DDR PC-2700 (8IC) 256MB 48
V-Gen DDR PC-2100 (16IC) 512MB 88
V-Gen DDR PC-2700 (16IC) 512MB 92
V-Gen DDR PC-3200 (8IC) 256MB 49
V-Gen DDR PC-3200 (16IC) 512MB 95
V-Gen RDRAM PC-800 128MB 51
V-Gen RDRAM PC-800 256MB 97

NCPRO 256MB DDR PC-3200 47
NCPRO 256MB DDR PC-2700 44
NCPRO 512MB DDR PC-2700 89
NCPRO 128MB DDR PC-2100 18
NCPRO 256MB DDR PC-2100 33

COMPACT FLASH

NCPRO Flash memory 32MB 16
NCPRO Flash memory 64MB 17.5
NCPRO Flash memory 128MB 29
NCPRO Flash memory 256MB 58.5

Visipro Flash Memory 64MB 24
Visipro Flash Memory
128MB 40
Visipro Flash Memory 256MB 68
Visipro Flash Memory 512MB 125

Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 185
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 275

Seagate Ux/Cuda 5400.1 20GB ATA 100 51
Seagate Ux/Cuda 5400.1 40GB ATA 100 59
Seagate Barracuda ATA IV /V 80GB
7200RPM ATA100 80
Seagate Barracuda 7200.7 40GB ATA100 62

SMART MEDIA CARD

NCPRO Flash Memory 32MB 12
NCPRO Flash Memory 64MB 19.5
NCPRO Flash Memory 128MB 27.5

Kingston Flash Memory 64MB 25
Kingston Flash Memory 128MB 39

USB FLASH MEMORI/MP3/
PEN DRIVE

Prolink USB Pen Drive, MP3 64MB 89
Prolink USB Pen Drive, MP3 128MB 120
Prolink USB Pen Drive, MP3 256MB 175

NCPRO pen drive 128MB 37
NCPRO pen drive 256MB 59.5
NCPRO pen drive 512MB 115
NCPRO pen drive 128MB USB2.0 44

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3, 128MB, MP3 115
DigiSound, 128MB, multi MP3,
voice recording, display 115
MagicStar 128 Turbo, USB 2.0, 128MB 70

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm
ATA133, 2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 65
Maxtor 6Y060L 60GB 7200rpm
ATA133, 8MB Cache, dual processor 80
Maxtor 6Y080L 80GB 7200rpm
ATA133, 8mb cache, dual processor 88
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 118
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Pemenang Kuis Edisi 137/III/2002:
HADIAH SOUVENIR PCplus

1. Arie Budiman
Jati Pulo Jl. Z No.20 RT.006/08
Kec. Palmerah - Jakarta 11430

2. Andy Kurniawan
Jl. Pijer Podi No.25 Kel. Sempakata
P. Bulan - Medan 20131

3. Sugiarto Lesmono
Perumahan Tenggilis Jl. Rungkut Mejoyo
Selatan II/N 17 - Surabaya 60292

4. A. Baso Harsul
Jl. Kerukunan Timur I Blok H No. 80
Makassar 90245

5. A.R. Yusuf L.
Jl. Aromanis No.59 Blok Z Perumnas
Karang Tengal, Cianjur - Jawa Barat 43281

KUIS Panges, kawan si Ciplus bilang. "Hati-hati kalo kamu pake
software bajakan, Plus, bisa kena tuntut loh". "Masa' sih, memang
ada undang-undangnya?", pikir si Ciplus. "Tolong dong si Ciplus,

sebutkan Undang Undang terbaru mengenai Hak Cipta, dan tanggal berapa mulai
berlakunya? Tuliskan jawaban tersebut di sehelai kartu pos dengan mencantumkan alamat
yang jelas dan sudah dibubuhi Kupon Kuis asli (di pojok kanan). Jangan menunda-nunda,
karena jawaban sudah harus masuk ke meja Redaksi PCplus paling lambat tanggal 22
September 2003. PCplus akan memberikan 5 buah kaos PCplus untuk 5 orang
pemenang yang menjawab dengan benar dan beruntung! Buruan!!!

Para pemenang tidak dibebani pungutan atau biaya apapun atas undian ini
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Jawaban Kuis No. 137/III/2002: Abit, Asus, Aopen, Intel, Gigabyte, MSI, dll

Seagate Barracuda 7200.7 80GB
ATA100 80
Seagate Barracuda 7200.7 120GB
ATA V/100 108
Seagate Barracuda 7200.7 Plus
160GB ATA V/100 (8MB cache) 165
Seagate Barracuda SATA 80GB,
ATA100 125
Seagate Barracuda SATA 120GB,
ATA100 143

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 52
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 54
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 60
Maxtor 4R060J/4D060H,
60GB 5400rpm, ATA-133,
2MB cache Call
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 83
Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache Call
Maxtor 4G160H, 160GB, 5400rpm,
9,0ms, ATA100, 2MB cache,
dual processor 172
Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 130
Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 160
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 220
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 275

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 5400rpm
cache 2MB 40GB 57
Western Digital WDC 7200rpm
cache 2MB 40GB 67
Western Digital WDC 7200rpm
cache 8MB 40GB 79
Western Digital WDC 7200rpm
cache 8MB 80GB 112
Western Digital WDC 7200rpm
cache 2MB 100GB 135
Western Digital WDC 7200rpm
cache 2MB 120GB 160
Western Digital WDC 7200rpm
cache 8MB 160GB 210

Samsung HDD 20GB 5400rpm 56
Samsung HDD 40GB 5400rpm 70

EXTERNAL DRIVE

Maxtor 5000DV 160GB, USB 2.0,
8MB Cache, 7200rpm 325
Maxtor 5000DV 200GB USB 2.0,
8MB Cache, 7200rpm 430

SCSI HARD-DISK 7200RPM &
10K RPM

Maxtor KU018L/J 18 GB ORCA,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 165
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 200
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 460

IBM IC35LO36UWD, 36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200
Quantum XC009J, 18GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 80
IBM IC35L009, 9GB, 68pin,
10Krpm, SCSI160,  8MB cache 115
IBM DPSS 9170W, 9,1GB, 68/80pin,
7200rpm, SCSI160,
4MB cache 95

Seagate Medalist Pro
4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah 10Krpm,
36,7GB U320, 36ES, 63,2ms, 4MB 190
Seagate Cheetah 10Krpm, 73GB,
U320, 36ES, 63,2ms, 4MB 530
Seagate Cheetah 15Krpm 18,4GB,
U160, x 3,9ms, 8MB cache 219
Seagate Cheetah 15Krpm 36,7GB,
U320, x 3,9ms, 8MB cache 397

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI, 640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300, 1300MB,
external firewire 450

PROSESOR

Athlon Xp 1800+ (Thoroughbred A) 48
Athlon XP 1900+ (Palomino) 48
Athlon Xp 2000+ (Thoroughbred A) 55
Athlon Xp 2100+ (Thoroughbred A) 58
Athlon XP 2200+ ((Thoroughbred A) 63
AthlonXP 2400+ fan (Thoroughbred A) 75
AthlonXP 2600+ (FSB333) + fan 90
AthlonXP 2800+ (Barton FSB333) 182
AthlonXP 3000+ (Barton FSB333) 266

Intel Pentium-4 1,6GHz)-423 126
Intel Pentium-4 1,8GHz, box, 478 138
Intel Pentium-4 3,06GHz, box), 478 Call
Intel Pentium-4 1,8AGHz, 512KB
cache L2, 478 Call
Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 Call
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 180
Intel Pentium-4 2,53GHz,
512KB cache L2, FSB 533, 478 Call
Intel Pentium-4 2,66GHz,
(512) FSB 533 211
Intel Pentium-4 2,8GHz
(512) FSB 533 280
Intel Pentium-4 2,4GHz, 512KB,
FSB800, 478 196
Intel Pentium-4 3.0GHz, 512KB,
FSB800, 478 Call

Intel Celeron 1,7GHz, c/128 64
Intel Celeron 1,8GHz, c/128 73
Intel Xeon Pentium-4 1,8GHz
512KB cache L2, MPGA 194
Intel Xeon Pentium-4 2,0AGHz,
512KB cache L2, MPGA 239
Intel Xeon Pentium-4 2,4AGHz,
512KB cache L2,FSB 533, MPGA 250
Intel Xeon Pentium-4 3,06
512KB cache L2, 533MHz 756

HEATSINK FAN

Coolermaster HAC-V81 (X-Dream) 21
Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19
Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000 ALCU 35

VGA CARD

Asus V9280 SuperFast 128MB 221
Asus V9180 Magic/T
64MB MX440-8X 84
Asus V9900, GeForceFX 5800,
AGP 8x, 128MB DDR 378
Asus V9520 Magic/T
GeForceFX 5200, 128MB, AGP8X 95
Asus V9959 Ultra/TD,
GeForceFX5900 588
Asus V8170 Magic/T,
GeForce 4 MX 420, 64MB DDR 63
Asus V9950 Ultra/TD,
GeForce FX5900, 256MB 588
Asus V7100 Combo,
GeForce 2 MX 400, 32MB 147

Abit GF3 Ti 200, 64MB DDR 120
Abit GF2 T400, AGP 4X,
64MB SDRAM, TV-out, 64
Abit GF2 MX400, AGP 4X,
64MB SDRAM 59
Abit GF2 T200, AGP4X,
32MB SDRAM, TV-out 56

Abit GF2 MX200, AGP 4X,
32MB SDRAM 49

PixelView GF4 Ti4200-8x, GPU 250MHz,
RAM Clock 500MHz, 128MB DDR,
TV-out & Video In, DVI Port 160
PixelView GF4 Ti4200-8x/64, AGP 8x,
GPU 250MHz, RAM Clock 500MHz
64MB DDR, TV-out 130
PixelView GF4 MX440-8x,
GPU 250MHz, 128MB DDR 5ns,
RAM Clock 400MHz, TV out,
video in, DVI 85
PixelView GF4 MX440-8x/64, GPU 250,
64MB DDR 5ns, RAM clock 400MHz
TV-out,in, DVI 55
PixelView GF4 MX440SE/DDR, GPU
250MHz, 64MB DDR 4ns, TV out 48
PixelView GF4 MX440SE/sd,
GPU 250MHz, 64MB SDRAM, TV out 45
PixelView FX5800, AGP8X, DDRII,
VIVO, DVI 490
PixelView FX5600H, AGP8X,
DDR 3,5ns, VIVO, DVI 205
PixelView FX5600, AGP8X,
128MB DDR, 3,6ns, DVI, VIVO 185
PixelView FX5200, AGP8X,
128MB DDR, TV OUT, DVI 98

MSI G4 MX440SES-T, AGP4X,
64MB SDR, TV OUT 58
MSI G4MX440 SET, AGP4X,
64MB SDR, TV OUT 64
MSI MX440-TD8X, AGP8X,
64MB DDR, DVI, TV OUT, DUAL CRT 91
MSI MX440-VTD8X, AGP 8X,
64MB DDR, DVI, VIDEO IN, TV OUT 110
MSI Ti4200-TD8X64, AGP8X,
64MB DDR, DVI 165
MSI TI4200-VTD8X, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 185
MSI FX5200-TDR128, 128MB DDR,
DVI, VIDEO IN, TV OUT 135
MSI FX5600-VTDR, AGP8X,
128MB DDR, DVI, VIDEO IN,
TV OUT 215

Elsa Gloria4 980XGL nVidia Quadro4
900XGL, 128MB DDR, 650MHz DVI-I 802
Elsa Gloria4 750XGL nVidia Quadro4
750XGL, 128MB DDR, 650MHz DVI-I 475
Elsa Synergy4, nVidia Quadro4
550XGL, 128MB DDR, 500MHz, DVI-I 301
Elsa Gladiac 518, nVidia GF4 MX440,
64MB DDRTV 83
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Minggu lalu, tepatnya
tanggal 11 Agustus,

ditemukan worm
bernama Blaster

(W32.Blaster.Worm)
yang memanfaatkan
celah keamanan RPC

(Remote Procedure
Call) DCOM (Distrib-

uted Component
Object Model). Worm
ini menyebar dengan

cepat. Pada hari
pertama

pemunculannya,
penyebaran Blaster

sudah menempati
urutan pertama.

PC adalah suatu
protokol yang dapat
digunakan oleh suatu
aplikasi untuk meminta

“layanan” aplikasi lain dari PC lain
yang berada di dalam satu
jaringan. Sedangkan DCOM
adalah interface yang digunakan
untuk RPC. Celah pada DCOM ini
memungkinkan penyusup untuk
menginstal aplikasi, melihat,
mengubah, serta menghapus data
dan membuat user account baru.

Sistem yang menggunakan
Microsoft Windows NT 4.0,
Windows 2000, Windows NT atau
Windows Server 2003 rentan
terhadap serangan virus ini.

Namun jika sudah di-patch dengan
security update dari security bulletin
MS03-026 tertanggal 11 Agustus,
Blaster tidak dapat menembus
sistem. Sedangkan pengguna
Windows 98, Windows 98 SE dan
Windows ME pun bisa santai.

Untuk mencegah dan
mengatasi Blaster menyerang PC,
segera update atas virus definition
antivirus yang ada. Symantec
menyediakan FixBlast untuk
memeriksa dan membasmi Blaster.
Namun cara menjalankannya tidak
bisa klik, jalan, lalu beres. Namun
ada beberapa hal yang perlu dicek
lebih dulu.

Akibat terserang Blaster, sistem
tidak mampu melakukan koneksi ke
Internet dan restart setiap beberapa
menit sekali.  Pada beberapa kasus,
khususnya di Windows 2000 dan
Windows XP, mengubah setting
untuk RPC dapat mengatasi
masalah ini. Langkah-langkah
berikut ini adalah cara untuk
mengubah setting RPC (jangan lupa

mengembalikan setting seperti
semula setelah Blaster terbasmi):
• Klik [Start>Run]
• Ketik services.msc /s. Klik [OK]

(lihat Gambar 1).
• Di bagian kanan window

yang muncul, cari Remote
Procedure Call (RPC) (lihat
Gambar 2).

• Klik kanan di situ, kemudian
pilih [Properties].

• Pada window yang muncul klik
tab [Recovery].

• Ubah isi menu drop-down untuk
First Failure, Second Failure

dan Subsequent Failure
menjadi [Restart the Service]
(lihat Gambar 3).

• Klik [Apply] lalu [OK].

Setelah PC terhubung ke
Internet, download FixBlast
(140KB) dari http://
securityresponse.symantec.com/

avcenter/
FixBlast.exe. Symantec
menganjurkan agar
FixBlast yang
digunakan adalah

FixBlast yang langsung di-
download dari situs mereka.

Sebelum FixBlast dijalankan,
fitur system restore
pada Windows XP
harus dimatikan,
karena Windows
mencegah suatu
aplikasi lain
mengubah system
restore. Setelah
system restore
dimatikan, baru
jalankan FixBlast (lihat Gambar 4).
Klik tombol [Start] untuk memulai
proses scanning.

Ketika FixBlast sedang
melakukan scanning dan
menemukan Blaster, ada
kemungkinan muncul pesan bahwa
FixBlast tidak mampu me-remove

satu atau beberapa file. Untuk
mengatasinya, matikan FixBlast.
Matikan PC, dan tunggu selama 30
detik. Nyalakan kembali PC dan
jalankan pada safe mode. Jalankan
kembali FixBlast.

Setelah proses scanning
selesai akan muncul berbagai
informasi seperti jumlah total file
yang di-scan, jumlah file yang
dihapus, jumlah proses yang
dilakukan oleh virus (viral process)
yang dihentikan dan jumlah
registry yang diperbaiki. Restart PC
Anda dan jalankan secara normal.
Untuk memastikan sistem sudah
bersih dari Blaster, jalankan

FixBlast sekali lagi. Kemudian
kembalikan seluruh setting seperti
sebelum instalasi FixBlast.

FixBlast yang di-download
pada tanggal 14 Agustus adalah
versi 1.0.4 yang sudah mampu
membasmi W32.Blaster.C.Worm,
versi Blaster terbaru. PC+Gambar 1 Gambar 3

Gambar 2

Gambar 4


